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Getting Started

Getting Started

File Structure and System Requirements
The software in this package is a folder named Green Globs containing these files:

v' Green Globs & Graphing Equations - an application file

v Globs/Tracker Records - a document file created by the application file
v' Green Globs Manual.pdf - a teacher’s manual

v Installation Notes for Green Globs - a brief text file

To copy these files onto your disk, you need about 4MB available disk space.

Upgrading from an Earlier Version

If you are upgrading from the previous version of Green Globs & Graphing Equations,
the Globs/Tracker Records files you were using with your previous version will work with
the new version automatically. The new application file Green Globs & Graphing
Equations has the same creator signature (‘GGGE?”) as the previous application file. By
default, OS X will use the new version when you open any Globs/Tracker Records file
or List file.

Installing Green Globs & Graphing Equations

To install Green Globs & Graphing Equations, copy the Green Globs folder from the
disk image (“DMG”) file you received to the Applications folder (or other folder of your
choice) of your hard disk drive. Teachers should put a password on their Globs/Tracker
Records file(s) before students use them. See the section “Teacher Options Password”
on page 6.

Starting Green Globs & Graphing Equations
There are three ways you can start Green Globs & Graphing Equations:

In any folder, open any Globs/Tracker Records file (or an alias for it),
including those from earlier versions of Green Globs & Graphing
Equations. To create Records files, see TEACHER OPTIONS on page 79.

In any folder, open any List file (or an alias for it). A List file contains a
list of Globs/Tracker Records files. Both Records files and List files can
be created using TEACHER OPTIONS, which are described on page 79.

In your Green Globs folder, open the Green Globs & Graphing Equations
application file (or an alias for it). If you use this method, the application
file will use document file “Globs/Tracker Records” in your Green Globs
folder.

Green Globs and Graphing Equations 1



Introduction

Introduction

Green Globs & Graphing Equations provides mathematical environments for students to
manipulate and explore. This may be quite different from the mathematics activities
students have experienced in the past. Students who use GREEN GLOBS become
creative learners, developing new strategies and innovative techniques.

The mathematical content of this package focuses on the relationship between
eqguations and their graphs. The programs are appropriate for a wide range of student
abilities and experience levels. Beginning algebra students or pre-algebra students who
are familiar only with graphs of straight lines can benefit from these programs. Math
analysis students who use trigonometric and discontinuous algebraic functions will also
be challenged.

Brief Program Descriptions
EQUATION GRAPHER is a utility program that plots the graphs of entered equations.

LINEAR & QUADRATIC GRAPHS displays a graph of a certain type (line, parabola, circle,
ellipse, hyperbola). The student enters an equation that matches the graph.

GREEN GLOBS is a game in which thirteen green globs are randomly placed on the grid.
Students earn points by entering equations that pass through as many green globs as
possible.

TRACKER is a game in which graphs are hidden on a grid. The student gathers clues to
determine the equations of the hidden graphs by using “probes” (horizontal and vertical
lines) to find the location of the graphs.

TEACHER OPTIONS provides tools for the teacher to manage the Records file(s). A
Records file holds the top ten scores recorded by students playing GREEN GLOBS or
TRACKER games.

The four programs (EQUATION GRAPHER, LINEAR & QUADRATIC GRAPHS, GREEN GLOBS,
and TRACKER) and TEACHER OPTIONS are all combined into one Macintosh application
file called Green Globs & Graphing Equations.

Suggested Program Uses

EQUATION GRAPHER s effective as a demonstration tool in classroom presentations to
introduce graphs of equations and to illustrate the concept of “what if.” (For example,
“What if we changed the equation? How would the graph change?”) It is also valuable
as a student activity with worksheets such as those included in this guide.

LINEAR & QUADRATIC GRAPHS is an individual or small group activity that will help
students master methods of transforming graphs by altering basic equations.

GREEN GLOBS is an individual or small group activity that enables students to apply
concepts relating equations and their graphs in a motivating, problem-solving situation.
It helps students develop creative strategies using equations.

TRACKER is an individual or small group activity that reinforces the understanding of
linear and quadratic relations in a game setting.

Green Globs and Graphing Equations 2



Introduction

Order of Use

The programs can be used in any order. Students can move within or between
programs without losing their work. For example, students could start playing a game,
go back to check the rules again, and then continue their game at the same point they
left it.

LINEAR & QUADRATIC GRAPHS is recommended as preparation for TRACKER. The “target”
graphs shown in LINEAR & QUADRATIC GRAPHS are of the same types as the hidden
graphs in TRACKER.

Time Requirements

The amount of time needed for effective use of these programs varies greatly. A few
minutes is sufficient for a demonstration using EQUATION GRAPHER. A thirty-minute
session is enough to use one part of LINEAR & QUADRATIC GRAPHS .

Several-hour sessions are necessary to develop a range of strategies for playing GREEN
GLoBs. Students who want to continue an unfinished GREEN GLOBS game at another
time can save it on disk using the “Save” option in the File menu. Teachers may find
the time commitment of these activities greater than the time they typically devote to
class presentations of this content. However, it should be noted that students here are
actually applying mathematics and developing creative strategies, not seeing or
listening to a demonstration.

The Teacher’s Role

Teachers who use Green Globs & Graphing Equations effectively act as facilitators. By
planting a few carefully-placed comments and asking questions, they encourage
students to explore their own ideas.

Teachers should encourage students to learn from each other, to build on others’ ideas,
and to explain their ideas to their group. Teachers can spark continued interest and
creativity in students by subtly guiding them toward new strategies that suit their ability
level and experience.

It is not an easy task to be aware of the students’ current strategies, share their
enthusiasm about their latest discovery, allow them to enjoy this achievement by
applying the idea several times and extending it to new cases, and yet at the same time
encourage them to move on to new ideas.

The Student’s Role

Students should try to develop basic strategies that can be applied to many graphs
rather than to memorize formulas. They can do this by experimenting, by using guess
and check, and by learning from their “mistakes”. Students should be encouraged to be
creative and innovative, to share ideas, and to build on others’ ideas.

Students may want to work individually or in groups of two or three.

Green Globs and Graphing Equations 3
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Teacher Instructions

General Instructions

The File, Edit and Programs menus are always on the menu bar at the top of the
screen. After you select a program from the Programs menu, a specific menu for that
program will be added to the menu bar. A Windows menu lists all open windows. Each
item you select appears in its own window. You can have up to 12 windows open at
one time, not counting the TEACHER OPTIONS window. Program title display windows are
automatically closed when you leave them. For security reasons, the TEACHER OPTIONS
window is automatically closed whenever you leave it. Other windows remain open until
you close them.

File Menu
Open... ¥0
Close HEW
Save... %S
Page Setup...
Print Display... ¥P
Copy Display to Clipboard

* Open...
« Save...

These are active only in EQUATION GRAPHER and GREEN GLOBS. Both use the standard
Macintosh dialog boxes for opening and saving files.

Save... is used to save on disk the current equations and display in EQUATION GRAPHER
or a game (in progress or finished) in GREEN GLOBS. You can also use Save... to save
displays prepared in EQUATION GRAPHER or GREEN GLOBS.

Open... is used to retrieve work saved on disk. The dialog box for Open... will offer for
selection only files containing work saved from the program you are currently in (either
GREEN GLOBS or EQUATION GRAPHER).

When you are finished with a file of saved work, you can delete it in the Finder. Green
Globs & Graphing Equations does not provide tools for managing files of saved work.
Users cannot open a saved work file in the Finder to start Green Globs & Graphing
Equations. Users who try that will see an alert box asking them to open Green Globs &
Graphing Equations first, select program GREEN GLOBS or EQUATION GRAPHER , and
then open the saved work file. (However, users can open a Records file in the Finder to
start Green Globs & Graphing Equations.)

Green Globs and Graphing Equations 4



Teacher Instructions

* Close

This closes the active window. It is the same as clicking the red button at the left end of
the window’s title bar.

» Page Setup...
* Print Display...
These provide the standard Macintosh dialog boxes for printing the active window.
» Copy Display to Clipboard
This puts a picture of the window on the user’'s Macintosh clipboard.
* Quit
This exits the application. The only work saved after a user chooses Quit is:
v' work that was saved on disk using the File menu item Save...

v' games in GREEN GLOBS or TRACKER which scored in the top ten, if the user
accepted the program’s offer to save them for others to see. A game saved this
way is not saved permanently; it will be bumped off the list and deleted if/when
enough other games with higher scores are saved.

Edit Menu

Cut X
Copy £ C
Paste EV
Delete

* Cut

+ Copy
+ Paste
* Clear

These are available when entering an equation or a name. There is no Undo option for
those situations.

* Undo

The only Undo options are the Undo Last Shot button in GREEN GLOBS and the Undo All
Zooms button in EQUATION GRAPHER. Those buttons appear on the user’s screen at the
appropriate times.

Green Globs and Graphing Equations 5
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Programs Menu

Equation Grapher #1
Linear & Quadratic Graphs 362
Green Globs 33
Tracker 384
Teacher Options 35

This menu lists the four programs for students, plus TEACHER OPTIONS. They are
assigned key equivalents for convenience. This menu is always available..
Teacher Options

TEACHER OPTIONS is the last item on the Programs menu. These options allow the
teacher to manage the record scoring games saved by students playing GREEN GLOBS
and TRACKER. In TEACHER OPTIONS, a teacher can do the following:

v' Change a misspelled or inappropriately chosen student name on a record game
See a replay of one or more record games

Delete one or more record games

Copy selected games from one records file to another records file

D N NI NN

Create new records files and lists of records files
See the TEACHER OPTIONS chapter on page 79 for detailed descriptions of those options.

Teacher Options Password

Access to TEACHER OPTIONS is restricted to those who know the password. The
password is kept (encrypted) in the records file. When a records file has not been
assigned a password yet, the first user to select TEACHER OPTIONS will be asked to set
the password for that records file. The teacher should do this before students start
using Green Globs & Graphing Equations; nothing further is required. For detailed
descriptions of password options, see page 81 in the TEACHER OPTIONS chapter.

How to Write Equations

After you choose one of the four programs (EQUATION GRAPHER, LINEAR & QUADRATIC
GRAPHS, GREEN GLOBS, or TRACKER), you will see a menu specifically for that program.
However, the first menu item on that menu will always be How to Write Equations. This
selection goes to a practice screen which tells the student how to enter equations and
provides a place to practice entering equations. The standard Macintosh editing keys
and mouse conventions are used, except that exponents are displayed as superscripts.
Exponents are limited to one-digit positive whole numbers.

The practice screen in How to Write Equations is the same for all four programs. Itis
included in each program’s menu for convenience getting started and so students can
easily refer to it.

Green Globs and Graphing Equations 6



Teacher Instructions

Here is what the students see when they select How to Write Equations:

How to Write Equations

Exponents
To write an exponent (as in XZ), type the & key, then type the exponent.

Exponents are limited to one digit positive whole numbers.

Convenience Keys
key ‘T acts like exponent key M
key [ actslike left parenthesis |
key ] acts like right parenthesis |

Egquation Editing
Use the mouse or the 4— and —* keys to move the pointer to the
place yvou want to change. Delete to the left of the pointer, or insert at it.
fou can also select from the Edit menu on the menu bar.

To erase everything in the equation entry box, press Shift-Delete.

Practice Here: }(2+( Y- 3) 2_16

Green Globs and Graphing Equations 7



Equation Grapher

EQUATION GRAPHER

X2/494Y2161 . . . . . . . .. L. ... ... .. |*x10
=8
Y=4SIN(X) SR

Zoom

Set
Bounds
X=-10
Y= -8

Y=4S IN(X)

Graphing completed. Edit this equation, or enter another.

Mouse is at X= -5.50, Y= 2.20

Overview
Grade Level: 6 - adult
Prerequisite Skills: use of a coordinate grid, graphing equations
Type: graphing utility for student or teacher use

Description

EQUATION GRAPHER plots the graphs of equations entered at the keyboard. The grid can
be either rectangular (as used in the other programs in this package) or square. The
grid bounds can be specified, and the user can zoom in or out. Acceptable forms of
equations include conics, as well as equations where:

y equals a function of x, or
x equals a function of y.
Functions may include trigonometric, square root, absolute value, natural logarithm, and
exponential functions.
Objectives
1. recognize basic shapes of graphs of equations
2. discover relationships between equations and their graphs
3. manipulate graphs by altering the corresponding equation
(Note: Objectives may vary depending on the instructional activities.)

Green Globs and Graphing Equations 8



EQUATION GRAPHER Menu ltems

Equation Grapher
How to Write Equations

See Instructions

Start Graphing on a Rectangular Grid: -10 < X

Start Graphing on a Rectangular Grid: -2m s X s 2m, -5sY =<5
Start Graphing on a Square Grid: -8 <X <8, -8sY <8

v Show Equations Beside Grid
Hide Equations Beside Grid

» How to Write Equations

Equation Grapher

This is the practice screen described under “How to Write Equations “ on page 6. Itis

the same for all programs.
» See Instructions

These are the instructions shown to students, on several screens. Buttons at the
bottom of each instruction screen allow students to navigate to the next and previous
screens. Here is what the students see (the buttons the students see are not shown

here):

Instructions

Types of Graphs
You can graph lines, parabolas, circles, ellipses, and hyperbolas.

For example:
Y=3 2X+Y = 3 X=1/3v
X=-6 XZ4+YE = G4 3(X-1)2-4(v-2)2 = 50

You can do other kinds of graphs if you write them as either:
¥ = an expression in X, for example: ¥ = 3x3-2x2
or X = an expression in Y, for example: X = Iye-5/(v-4)4

Graphed equations are shown beside the grid unless you select the
menu option to hide them.

Exponents

Exponents are limited to one digit.

To write an exponent (as in XZ), type the A key, then type the exponent.

(Instructions are continued on the next page.)

Green Globs and Graphing Equations



Function Names

Special Functions
You can also use these functions:
abs, sgr, log, exp, sin, cos, tan, csc, sec, cot, atn.

abs means absolute value.

sQr means sguare root .

log means pafural fog, the inverse of the exponential function exp.
atn means arcitangent.

Parentheses
Use parentheses around function arguments. Write sin(2X), not sin2X.

Pi
To make the symbol w (pi), type the letter p.

Foom
Coordinates

To show the coordinates of a point on the grid, just move the mouse
to it (without clicking).

Zoom
To improve the accuracy of graphs (such as in an area where graphs
intersect), click the Z00M button, set the Zoom Center Point in
that area, and click ZOOM IN several times.

¥ou can click on Z00M [N or Z00M OUT several times at once,
without waiting for the graphs to be re-drawn after each click.

To return to the grid boundaries you had before you started zooming,
click on UNDO ALL ZOOME.

Grid Boundaries
To set upper and lower grid boundaries, click on SET BOUNDS.

Copying, Frasing, & Saving

Copying
To copy a previously graphed eguation to your clipboard, click on it
and choose 'Copy' from the Edit menu. Then you can Paste it into
the eguation you're working on.

Erasing
You can have up to 10 graphs on the screen at once. To erase a graph

you don't want, click on its equation (to the left of the grid) and
press the DELETE key. To delete several at once, hold down the
SHIFT key as you click each equation (or hold down the mouse button
as you drag across the equations), then press the DELETE key.

Saving
To save your work, select 'Save...' from the File menu. Saved work
can be continued later by selecting 'Open...' from the File menu.

Green Globs and Graphing Equations
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Equation Grapher

+ Start Graphing on a Rectangular Grid: -10=X <10, -8<Y <8
» Start Graphing on a Rectangular Grid: -2m<X<2m, -5<Y<5
+ Start Graphing on a Square Grid: -8 <X<8, -8<Y<8

The above three menu items all lead to the graphing display. The differences are the
shape of the grid (rectangular or square) and the initial values for grid boundaries. All
three choices result in a grid where one unit horizontally looks about the same length as
one unit vertically. On the graphing display, the grid keeps its shape as the grid
boundaries are changed by clicking the Set Bounds or Zoom buttons (described below).

« Show Equations Beside Grid
» Hide Equations Beside Grid

The last two items on the EQUATION GRAPHER menu control whether equations for the
current graph are shown at the left of the grid. When the program is started, the setting
is Show Equations Beside Grid. The current setting has a check mark next to it. You
can change the setting at any time—select the setting you want from the menu and the
check mark will switch to it. The setting remains in effect as long as you are in the
program. When you select Open... from the File menu to get a previously saved
EQUATION GRAPHER display, the program uses your current setting for Show Equations
Beside Grid/Hide Equations Beside Grid, not the setting in effect when the display was
saved.

Graphing Display Features and Buttons

The graphing display shows the coordinate grid, a box for entering an equation, and
three buttons (Zoom, Set Bounds, and Graph Equation).

When the mouse pointer is moved (without being clicked) over a point on the grid, that
point’s grid coordinates are shown at the bottom of the screen. The mouse pointer’s
coordinates will usually have two or three more significant digits than the grid
boundaries, up to a maximum of ten significant digits.

You can have up to ten equations graphed on the grid at one time. If you try to graph
an eleventh equation, you will be asked to erase one of the existing equations first.

Each graph’s equation will be displayed at the upper left of the screen, unless you have
checked the menu item to hide equations.

To erase one or more equations and their graphs, first select the equations by clicking
on them to the left of the grid. (Don'’t click on the grid — that would set the Zoom center
point, not select the equation.) To select more than one graph, either drag the mouse
through them or hold down the #3 key while you click each one. Then press the
Delete key, or select Edit menu items "Cut" or "Clear". (If you select an equation and
then select Edit menu item "Copy " or "Cut", a copy of the equation will be placed in
your clipboard.)
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Equation Grapher

Graph ‘
‘M After entering an equation, click the graph equation button to graph the
eqguation. If there is no equation entered, or the entered equation has just been
graphed, this button will be inactive. If the equation cannot be evaluated, a diagnostic
message will be displayed when this button is clicked. The blue color on this button
indicates that pressing the Return key is equivalent to clicking this button.

Set
| _ Bounds | Click this button to set one or more grid boundaries. You will see a
dialog box showing the current values for Lower X, Upper X, Lower Y, and Upper Y. To
change the number in a box, click in the box or use a key to move to that box. The tab
key cycles through all four boxes with repeated presses; shift+ tab cycles in the reverse
direction. You may also use the up arrow or down arrow keys to move. Your changes
do not take effect until you click OK. To ignore all changes, click Cancel. Grid
boundary numbers can use up to five digits and can include Tr(pi). For example, [.003,
.004] and [-311/2, 211] are valid grid boundaries. To enter 1, press the letter p.

Zoom
|"~ | When you click the Zoom button, you will be instructed to click the
mouse on the grid point you want to be the center point for zooming. (As a shortcut to
start zooming, just click the grid without pressing Zoom.) You can move the zoom
center point at any time just by clicking another grid point. If you hold down the shift key
when you click the mouse (shift-click) to set the Zoom center point, the Zoom center
point will be set to the nearest grid mark. For example, you can set the Zoom center
point exactly at (0,0) by moving the mouse pointer somewhere close to (0,0) and then
shift-clicking.

After you set the Zoom center point, the Zoom button is replaced by four new buttons:

| Zoom In
“ This draws a new grid with the zoom center point in the middle of the

screen and about half the previous grid’s horizontal and vertical dimensions.

| ZoomOut | _ o . .
- This draws a new grid with the zoom center point in the middle of the

screen and about twice the previous grid’s horizontal and vertical dimensions.

| Exit Zoom |
" This removes the four Zoom buttons and erases the zoom center point
marker from the grid, without affecting the current graphs and grid boundaries.

|' Undo

AllZooms J 1 restores the grid boundaries to the values they had before you

started zooming. For example, if you were comparing two graphs and zoomed in
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Equation Grapher

several times to determine their intersection point more accurately, you can quickly
restore your original grid boundaries by clicking Undo All Zooms.

You can add or delete graphs while the zoom buttons are available. The zoom buttons
remain available until you click Exit Zoom, or until you click Set Bounds and set grid
boundaries which do not enclose the zoom center point.

Zoom In and Zoom Out become inactive when their respective limits are reached in
either the x or the y dimension. The limit is reached when there would not be enough
room to display all the digits required to accurately indicate the new boundary. If you
want to zoom in or out further and the respective button is inactive, you can click

Set Bounds and enter the boundaries you want.

Ideas for Classroom Use

Teacher Demonstration Tool

As a classroom demonstration tool for teachers, EQUATION GRAPHER quickly and
accurately plots graphs of equations. It can be used on a large-screen monitor or video
projector to enhance presentations involving graphs of equations.

The teacher or students can choose equations to be graphed and see the result on the
screen. The general “what if” question can be asked and the outcome quickly
observed. For example, “What if we added 4 to the equation? What if we divided the
equation by 27"

The teacher may want to enter an equation and show only the graph to the students.
Then the class might discuss ways to determine an equation that matches the graph.
This activity is recommended as preparation for the LINEAR & QUADRATIC GRAPHS
program.

Student Utility

Students can use this graphing utility to explore the relationships between equations
and graphs. Using worksheets such as those included in this manual, students can
learn mathematical concepts and experiment with graphing techniques.

Green Globs and Graphing Equations 13



Equation Grapher

EQUATION GRAPHER Worksheets for Students — Overview
Worksheet 1 is a summary of the instructions students see in the program.
Worksheet 1: Instructions for EQUATION GRAPHER (page 15)

Worksheets 2 through 6 are introductory activities which may be useful as preparation
for LINEAR & QUADRATIC GRAPHS and TRACKER. They also provide computer graphing
activities to accompany the corresponding chapters in a textbook.

Worksheet 2: Graphing Lines (page 16)
Worksheet 3: Graphing Parabolas (page 19)
Worksheet 4: Graphing Circles (page 23)
Worksheet 5: Graphing Ellipses (page 25)
Worksheet 6: Graphing Hyperbolas (page 27)

Worksheets 7 and 8 target techniques that students may find useful in playing
GREEN GLOBS.

Worksheet 7: Exploring Roots (page 31)
Worksheet 8: Passing Through Points (page 33)

Worksheets 9 through 12 are intended for students who have had considerable
experience with GREEN GLOBS and are ready to investigate advanced mathematical
concepts.

Worksheet 9: Advanced Techniques — Sums of Functions (page 36)

Worksheet 10: Advanced Techniques — Trigonometric Functions (page 38)
Worksheet 11: Advanced Technigues — Sums with Trigonometric Functions (page 40)
Worksheet 12: Advanced Techniques — Absolute Value Function (page 42)
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EQUATION GRAPHER
Worksheet 1: Instructions for EQUATION GRAPHER

EQUATION GRAPHER plots graphs of equations on a coordinate grid. You enter the
equations from the keyboard. While you are graphing, you can review the instructions
in the program without losing your work.

Changing Bounds on the Grid

You select either a rectangular or square grid. You can change the bounds at any time
by clicking the Set Bounds button or the Zoom button. The bounds can be expressed in

terms of 1 (pi) by typing the letter “p” for 1. You may need to change the bounds in
order to see your graph more accurately or to examine its behavior over a larger or
smaller range.

Entering Equations
The equations you enter can include the following:

- lines, parabolas, circles, ellipses, hyperbolas
(for these, write your equation using x and y only once)

- equations where y equals a function of x

- equations where x equals a function of y

- trigonometric functions: SIN, COS, TAN, CSC, SEC, COT, ATN (arc tangent)
- square root: SQR

- absolute value: ABS

- natural logarithm: LOG

- exponential function: EXP

Erasing Graphs

You can graph up to ten equations on one grid. To erase a graph, click on its equation
to the left of the grid, and then press the delete key. Be sure to click on the equation to
the left of the grid, not on the grid — clicking on the grid sets the Zoom center point.

Changing the Equation

Your equation remains on the screen after it has been graphed. You can edit it to make
your next equation, or you can delete it and enter a new equation.

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey 15



EQUATION GRAPHER

Worksheet 2: Graphing Lines (page 1 of 2)
Enter each set of equations on the same coordinate grid. Observe the differences and similarities among

the graphs.

Sketch the graphs on the grids at the right.

1.x=5

X=-6

x=35

How might you describe all of

these lines?

2.y=2

y=-4

y=-55

How might you describe all of

these lines?

3.y=X

y=x+3

y=X+6

y=x-4

y=x-1

a. Whatis alike about all these

lines?

b Where does each line cross the

y axis?

c. What happens to the graph when a

constant is added to y = x?

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER

Worksheet 2: Graphing Lines (page 2 of 2)

4.y =X

y =2X

y =5x

y =-3X

a. What happens to the graph when x
is multiplied by a positive number

greater than 17

b. What happens to the graph when x
is multiplied by a negative number

less than -1?

5.y =1/2x

y = 1/4x

y =-1/3x

y = -1/5x

a. What happens to the graph when
x is multiplied by a number
between 0 and 1?

b. What happens to the graph when x
is multiplied by a number between
-1 and 0?

6.y =2x
y=2x+3
y=2x-7
y =-2X

y=-2x+5

7.y =.5x
y=.5x+2
y=.5x-4
y = -.5X
y=-5x+5

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER

ANSWERS Worksheet 2: Graphing Lines

1. All are vertical.

3a. All have the same slope
(same tilt, same direction).

3b. (0.0), (0.3), (0.6), (0,-4), (0,-1)
3c. It moves up or down on the

grid.

5a. It gets flatter, closer to
horizontal.
5b. It gets flatter.

2. All are horizontal.

4a. It gets steeper, closer to vertical.
4b It gets steeper, closer to vertical,

but it slopes in the opposite direction.
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EQUATION GRAPHER

Worksheet 3: Graphing Parabolas (page 1 of 2)

Graph each set of equations on the same coordinate grid using the program EQUATION GRAPHER.
Observe the differences and similarities among the graphs. Sketch your results in the grids.

vertex
l.y= X2 .
y = (x+1)° .
y = (x+3)? -
y = (x-2)* -
y = (x-5)°

What happens to the graph when you add a constant to the x term
before it is squared?

2. vertex Does it touch or cross the

x-axis? List the points.

y=x

(y+2) = X% or y= X2

(y+4) = x* ory = X*-4

(y-3) = x* ory = x*+3

(y-6) = X" ory = x*+6

What happens to the graph when you add a constant to the y term
in the equation?

3.y= X2
y= 2x°
y = 5%
y= 1/2%2
y = 1/6X°

What happens to the graph when you multiply the x? term by a
positive constant?

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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4.y=x2
y=x

y= -(x+3)2
y= -1/5x

What happens to the graph when you multiply the x* term by a
negative number?

5.x = y?

X = (y-3)°

X = 4y2

X =1/2y*+ 4
X = -3y*

What happens to the graph when you reverse the x and the y in the

equation?

EQUATION GRAPHER
Worksheet 3: Graphing Parabolas (page 2 of 2)

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER
ANSWERS Worksheet 3: Graphing Parabolas (page 1 of 2)

1. vertex \ T 1) A T S /
(-1,0 \ / /{ F:
(-3,0) . R ,/
(0,0)
(2,0)
(5,0)

The graph moves right or left.

2. vertex Does it touch or cross x-asix?
(0,0) vyes
(0,-2) vyes, at(-1.4,0) and (1.4,0)
(0,-4) vyes, at (-2,0) and (2,0)
(0,3) no
(0,6) no

The graph moves up or down.

3.

The graph becomes steeper or flatter.
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EQUATION GRAPHER
ANSWERS Worksheet 3: Graphing Parabolas (page 2 of 2)

The graph is “upside down” -- it opens downward.

i

_ j )

The graph opens to the left or right instead of up or down.
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EQUATION GRAPHER
Worksheet 4: Graphing Circles

Graph each set of equations on the same coordinate grid in EQUATION GRAPHER. Observe the differences

and similarities among the graphs.

Sketch the graphs.

1. x2+y2 =4
x2+y2 =9

x2+y2 =16
x2+y2 =25

a. How does the graph of the circle change when the constant

term increases?

b. Where is the center of each of these circles?

2. center
(x+1)*+y* =16
(x+3)°+y* =16
(x-4)2 +y* =16
(x-6)°+y* = 16

How does the graph change when a constant is added to the x term

before it is squared?

3. center
X2+ (y+4)? = 25
X2+ (y+1)° = 25
X2+ (y-1)> = 25
x>+ (y-5)° =25

How does the graph change when a constant is added to the y term

before it is squared?

4, center
(x+1)°+ (y-2)* = 16
(x-3)°+ (y-4)> = 25
(x+4)? + (y+5)° = 36
(x-2)°+ (y+3)* =9
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EQUATION GRAPHER
ANSWERS Worksheet 4: Graphing Circles

1.
X2+ y2: 4

X2+ y2: 9

X+ yZ: 16
X+ y2: 25

a) the radius increases

b) (0, 0)

2. center

(x+1)°+y* =16 (-1, 0) LR
(x+3)*+y” = 16 (-3,0) g
(x-4)*+y* =16 (4, 0) ) :
(x-6)%+y? = 16 (6, 0) N A

The center moves right or left (on the x axis)

3. center
X+ (y+4)* = 25 0, -4)
X2+ (y+1)? = 25 (0, -1)
X+ (y-1)? = 25 (0, 1)
X2+ (y-5)° = 25 (0, 5)

The center moves up or down (on the y axis)

4, center
(x+1)*+ (y-2)* = 16 (-1,2)
(x-3)%+ (y-4)? = 25 (3, 4)
(x+4)%+ (y+5)? = 36 (-4, -5) f
(x-2)*+ (y+3)* =9 ,-3)

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER
Worksheet 5: Graphing Ellipses
Graph each set of equations on the same coordinate grid in EQUATION GRAPHER. Observe the differences

and similarities among the graphs. Sketch the graphs.
1. vertices

X219 + y2 =1
X9 +y%4 =1
X219 +vy219 =1
X9 +y?25 =1

How does the graph change as the denominator of the y term
changes?

2. vertices
X2+ y2/16 =1
X4 +y/16 =1
x%/16 +y?/16 =1
X125 +y416 =1

How does the graph change as the denominator of the x term
changes?

3. vertices
X9 +vyP4 =1

(x-2)%19 + y°/4 =1
(x+3)%9 +y/4 =1

4, vertices
X9 + (y-4)%44 =1
X219 + (y+5)%/4 =1

5. vertices
(x-3)716 + (y+2)%/25 =1

(x+4)*/36 + (y-3)%/9 = 1
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EQUATION GRAPHER

ANSWERS Worksheet 5: Graphing Ellipses

1. vertices:

(3,0) (-3,0) (0,1) (0,-1)

(3,0) (-3,0) (0,2) (0,-2)

(3,0) (-3,0) (0,3) (0,-3) (acircle)
(3,0 (-3,0) (0,5) (0,-5)

The graph becomes shorter or taller. The vertices move farther out
along the y-axis as the denominator increases.

2. vertices:

(1,0) (-1,0) (0,4) (0,-4)

(2,0) (-2,0) (0,4) (0,-4)

(4,0) (-4,0) (0,4) (0,-4) (acircle)
(5,0) (-5,0) (0,4) (0,-4)

The graph becomes wider or narrower. The vertices move farther
out along the x-axis as the denominator increases.

3. vertices:

(3,0) (-3,0) (0,2) (0,-2)
(5,0) (-1,0) (2,2) (2,-2)
(0,0) (-6,0) (-3,2) (-3,-2)

4, vertices:
(3,4) (-3,4) (0,2) (0,6)
(3,-5) (-3,-5) (0,-3) (0,-7)

5. vertices:
(-1,-2) (7,-2) (3,3) (3,-7)
(-10,3) (2,3) (-4,6) (-4,0)

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER

Worksheet 6: Graphing Hyperbolas (page 1 of 2)
Graph each set of equations on the same coordinate grid in EQUATION GRAPHER. Observe the differences

and similarities among the graphs. Sketch the graphs on the grids below.
1. vertices

X-y*=1

X214 - y2 =1

X9 -y? =1

X425 -y* =1

How does the graph change when the denominator of the x term
changes?

2. vertices
X2 - y2 =1

X - y2/4 =1

x2-y?/36 =1

X-y2I64 =1

How does the graph change when the denominator of the y term
changes?

3. vertices

X116 - y/25 =1

(x-3)°/16 - y?/25 =1

(x+2)%/16 - y?/25 =1

How does the graph change when a constant is added to the x term

before squaring?

4. vertices

X216 - (y-2)°/25 =1

X%/16 - (y+4)%/25 =1

How does the graph change when a constant is added to the y term

before squaring?
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EQUATION GRAPHER
Worksheet 6: Graphing Hyperbolas (page 2 of 2)

vertices
5. (x+2)%/25 - (y-1)?/16 =1

6. y/16 -x°/9 =1
yi9 - x4 =1

How does the graph change when the x and y are
reversed in the equation?

7. The graphs of these equations are also
hyperbolas. How are these graphs different from
those above?

vertices

7a. xy=1

Xy =9

Xy =25
7b. xy =-16
Xy = -4

What are the equations of the lines on which the
vertices lie?

8a. (x-3)y=1
x(y+4) =1

8b. (x+2)y =-1
X(y-5) = -1

How does the graph change when you add a
constant to the x or the y term?

9a. xy=4
x(y+4) =4
x-2)y=4

9b. xy =-9
(x+3)(y-2) =-9

How does the graph change when you change the
constant term?

7b

8b

9a

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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EQUATION GRAPHER
ANSWERS Worksheet 6: Graphing Hyperbolas (page 1 of 2)

N

(1,0) and (-1,0)
(2,0) and (-2,0)
(3,0) and (-3,0)
(5,0) and (-5,0)

The vertices move farther out along the x-axis
as the denominator increases.

1

Vertices for all graphs are (1,0) and (-1,0).
The graph becomes more vertical as the
denominator increases.

(4,0) and (-4,0)
(7,0) and (-1,0)
(0,0) and (-8,0)

The graph moves right or left.

4.

(4,2) and (-4,2)
(4,-4) and (-4,-4)

The graph moves up or down.

(3,1) and (-7,1)

V7
N\

(0,4) and (0,-4)

(0,3) and (0,-3)

The graph opens upwards and downwards
instead of sideways.
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EQUATION GRAPHER

ANSWERS Worksheet 6: Graphing Hyperbolas (page 2 of 2)

7.

The graphs are rotated. They lie
entirely inside the first and third
guadrants of the grid.

(1,1) and (-1,-1)

(3,3) and (-3,-3)

(5,5) and (-5,-5)

The graphs here lie entirely inside the

second and fourth quadrants of the grid.

(_414) (41_4)
(-2,2) (2,-2)
The equations of the lines on which the

vertices liearey = xand y = -X.

8a. 8b.

7a.

9a. 9b.

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey

8.
The graph is shifted

horizontally or vertically.

9.

Changing the size of the
constant term changes the
curvature of the graph and

the distance between its vertices.
Changing the sign of the

constant term reflects the graph

with respect to an asymptote.
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EQUATION GRAPHER

Worksheet 7: Exploring Roots

Use the program EQUATION GRAPHER to plot the graphs of the equations in the exercises below.

A. Plot the graph of y = X2 - 4x + 3.

Where does the graph cross the x axis (What are the roots of the
equation?)

Factor the right side of the equation y = x* - 4x + 3

y=( ) )
Compare the factors with the roots. What do you
notice?

B. Plot the graph of y = x% - 3x - 10.

Where does the graph cross the x axis (What are the roots of the
equation?)

Factor the right side of the equation y = x*-3x+3

y=( X )

Compare the factors with the roots.

1. Write an equation of a parabola that crosses the x axis at the points (-2,0) and (2,0).

Plot it and see if you are correct.

2. Write an equation of a parabola that crosses the x axis at the points (2,0) and (6,0).

3. Write an equation of a parabola that crosses the x axis at (-5,0) and (1,0).

Plot it and see if you are correct.

4. Write an equation of a parabola that crosses the x axis at (1.5,0) and (4.5,0).

5. Write an equation of a parabola that passes through the points (-4,3) and (4,3).

6. Write an equation of a parabola that passes through the points (2,-4) and(6,-4).
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EQUATION GRAPHER
ANSWERS Worksheet 7: Exploring Roots

N

The graph crosses the x axis at (1,0) and (3,0). The graph crosses the x axis at (-2,0) and (5,0).
The roots are 1 and 3. The roots are -2 and 5.

y=(x-1)(x-3) y=(x-5)x+2)

For each root R, there is a factor (x-R). For each root R, there is a factor (x-R).

In the equations below , “c” can be any non-zero constant and the equation will be a correct answer.
1.y =c(x + 2)(x - 2) for example, y = X2 -4

2.y =c(x - 2)(x - 6) for example, y =x* - 8x + 12

3.y =c(x + 5)(x - 1) for example, y =x* + 4x - 5

4.y =c(x - 1.5)(x - 4.5) for example, y = X - 6x + 6.75

5.y=c(x+4)(x-4)+ 3 for example, y= x?-13

6.y =c(x-2)(x - 6) - 4 for example, y = (x2 -8x+8)
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EQUATION GRAPHER
Worksheet 8: Passing Through Points (page 1 of 2)

This worksheet describes one way to find an equation whose graph crosses the x axis at (-4,0) and (5,0)
and that also passes through the point (3,-7).

First, locate these points on a grid. Clearly, a straight line will not pass through these three points, so
consider a second degree equation.

Using the divide and conquer strategy, consider just the two points on the x axis: (- 4,0) and (5,0).
At these points, y equals zero.
Using guess and check, create two factors to multiply together and set them equal to y.

The factors must be chosen so that when x = - 4 or x = 5, the product of the two factors is zero.

y=(C ) )

Check that this graph does cross the x axis at x = - 4 and at x = 5 by entering it into the Equation
Grapher program and observing the graph.

(If your first try did not work, modify the equation on the basis of what you see and try again.)

Look to see if this graph passes through the other point, (3,-7). It probably does not.
We want a graph that passes through (3,-7). So we want an equation which is true forx =3 and y = -7.

First, substitute 3 for x in the equation above, to find the value of the equation we have at x = 3.

y=(x )x )

y=Q3 )@ )
y=(C ) )
y=-14

We want the value of y to be -7, not -14. Since -14/2=-7, we need to divide the expression on the right
side of our equation by 2.

y=(x+4)(x-5)/2

Graph this equation to see if it passes through all three points.
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EQUATION GRAPHER

Worksheet 8: Passing Through Points (page 2 of 2)

1. Now change your equationy = (x + 4) (x - 5) / 2 to get a new equation whose graph crosses the x axis
at the same points, but passes through the point shown below instead of the point (3,-7).

a. (3, 28) y=
b. (3, -21) y=
c. (1, -10) y=
d. (1, 5) y=

2. Write an equation whose graph crosses the x axis at (-2,0) and (3,0) and passes through the
point (-1,-1).
y =

3. Write an equation whose graph crosses the y axis at (0,-1) and (0,3) and passes through the
point (6,0).

4. Write an equation whose graph crosses the x axis at (2,0), (-2,0), (-5,0) and passes through the
point (-4,6).
y =

Here are some grids for sketching (optional).
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EQUATION GRAPHER

ANSWERS Worksheet 8: Passing Through Points

Answers for Page 1:
y = (x + 4) (x — 5) goes through the points (- 4,0) and (5,0).
It does not go through the point (3, - 7).

y = (X +4) (x=5) / 2 goes through the points (- 4,0) and (5,0).
It also goes through the point (3, - 7).

Answers for Page 2:

la.y=-2(x+4)(x-5)
1b.y=3/2(x+4) (x-5)

lc.y=1/2 (x+4) (x-5)

1d.y=-1/4 (x+4) (x-5)
2.y=(x+2)(x-3)/4or y=214 (x+2)(x-3)

3.x=-2(y+1)(y-3)

4.y=1/2 (x-2)(x+2) (x+5)
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Calculating the value of y when x = 3

in equationy = (x + 4) (x — 5):
y = (x+4) (x-5)
y=(3+4)(3-5)

y=(7)(-2)
y=-14
2.
3.
4.
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EQUATION GRAPHER

Worksheet 9: Advanced Techniques - Sums of Functions
This activity demonstrates the effect of adding a term of the form 1/x to a function.

1. Using the EQUATION GRAPHER program, graph the following

rational functions:

y=1/x, y=1/(x-2), and y=1/(x+4)

Observe the results. What happens at the values x = 0 in the first

graph, x = 2 in the second graph, and x = - 4 in the
third?

What happens to the denominator in each equation at these values

of x?

2a. Using EQUATION GRAPHER and a
blank grid, graph the equation y = 1/(x - 2).
Sketch the graph on the first grid at the right.

2b. Recall the graph of the line y = x.
Graph it on the computer if you wish.

Sketch its graph also on the first grid at the right.

2c. Now use the computer to graph the equation
formed by adding the term 1/(x - 2) to the equation
of the liney =xto gety =x+ 1/(x - 2).

Sketch the graph on the second grid at the right.
Describe the graph.

3a. Graph the equation y = 1/(x - 1). Sketch the
graph on the first grid at the right.

3b. Graph the parabola y = x*/4. Sketch the graph
also on the first grid at the right..

3c. Use the computer to graph the equation
formed by adding x?/4 and 1/(x — 1) to get

y= X2/4 + 1/(x - 1). Sketch the graph on the second
grid at the right. Describe the graph.
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1.

The graph is not defined at
those values of x.

The denominator is zero.

2.

The graph of y = x + 1/(x — 2)
looks like the graph of y = x
except near x = 2.

Near x = 2, the graph looks
like the graph of y = 1/(x — 2).

3.

The graph of y = X214 + 1/(x -1)
looks like the graph of y = x*/4
except near x = 1.

Near x = 1, the graph looks
like the graph of y = 1/(x — 1).

EQUATION GRAPHER
ANSWERS Worksheet 9: Advanced Techniques - Sums of Functions
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EQUATION GRAPHER

Worksheet 10: Advanced Techniques - Trigonometric Functions

Graph each set of equations on the same coordinate grid. Notice the similarities and differences.
Sketch the graphs. The ideas you get from these activities may help you play the Expert Game in

GREEN GLOBS.
1. Graphy = SIN(X)
y = 5SIN(x)
y = SIN(5%)
a. What is the effect of putting a coefficient in front of the

SIN function?

b. What is the effect of putting a coefficient in front of the

X inside the SIN function?

2. Graph x = SIN(y)
X = 6SIN(y)
X = 6SIN(4y)
What differences are there between the graphs in this set and

those above?

o T 9 bH O T 9 W
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Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey

. Graph

.y = TAN(X)
.y = TAN(X)/8
.y = TAN(3x)

. Graph

. X =TAN()

. X = TAN(5y)/2
. Xx= TAN(y)/3

. Graph

.y = SEC(x)
.y = SEC(3%)
. X = SEC(y)
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EQUATION GRAPHER
ANSWERS Worksheet 10: Advanced Techniques - Trigonometric Functions

la. The height of the graph is increased.

It is stretched up and down.

1b. The period is smaller. The graph is

squeezed together sideways.

2. These graphs lie along the

y-axis rather than the x-axis.
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EQUATION GRAPHER

Worksheet 11: Advanced Techniques - Sums with Trigonometric Functions

Interesting graphs can be produced by adding two functions. Try these examples of sums of functions,
then create some combinations of your own.

Graph the equations on the computer with EQUATION GRAPHER, then sketch the graphs on paper so you'll
have a record of them. The ideas you get from these sum equations may prove helpful when you play the
Expert Game in GREEN GLOBS.

1. Graphy =x
y = SIN(X)
and y = x + SIN(X)
Describe the graph of the sum

equation y = x + SIN(x)

2. Graphy =-x/2
and y = - x/2 + 3SIN(x)
Describe the graph.

3. Graphx=y
and x =y + 4SIN(y)
Describe the graph.

4. Graphy=2x-3
and y = 2x - 3 + 4SIN(3x)
Describe the graph.

5. Graphy = x°/4
and y = x°/4 + SIN(4x)
Describe the graph.

6. Try using COS(x) and other
variations of the above

equations.
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EQUATION GRAPHER

ANSWERS Worksheet 11: Advanced Techniques - Sums with Trigonometric

Functions

1. The graph is a slightly wavy curve along the path of y = x.

2. The graph is a bumpy curve along the path of y = - x/2

3. The graph is a very wavy curve along the path of x =y.

4. The graph is a very sharp curve along the path of y = 2x - 3.

5. The graph is a wavy curve along the path of y = x2/4.
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EQUATION GRAPHER

Worksheet 12: Advanced Techniques - Absolute Value Function (page 1 of 2)
The absolute value function can be combined with other functions to produce interesting effects.

Try these examples, then create innovative graphs of your own.
Graph the equations on the computer using EQUATION GRAPHER, then sketch the graphs on paper,

so you will have a record of them to refer to when you play GREEN GLOBS.

1. Sketch the graphs of y=x and y = ABS(x).

2. Use the computer to graph these equations. Sketch them on the grids below. Describe each graph.

y = ABS(2x - 3) y = ABS(2x) — 3

4. You know the graph of y = X2
What does the graph of y = ABS(x®) look like?

3. Graph x=ABS(y) and x = ABS(y/4).
Sketch the graphs on the grid below.

Describe the graphs.
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EQUATION GRAPHER

Worksheet 12: Advanced Techniques - Absolute Value Function (page 2 of 2)

5a. Graph y=x*-5and y = ABS(X*- 5).
Describe the graphs.

5b. Graph y = ABS(X*- 5) - 7. Describe the graph.

6. Try using the absolute value function
with trigonometric functions.
6a. Graph y = TAN(x) and y = ABS(TAN(X))

6b. Graph x = TAN(y) and x = ABS(TAN(y))

7. Try using the absolute value function with
another function.

Graph y = ABS(3TAN(X)) + x
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EQUATION GRAPHER
ANSWERS Worksheet 12: Advanced Techniques - Absolute Value Function (p. 1 of 2)

1. y=x y = ABS(X).
2.
y=2x-3 y = ABS(2x - 3) y = ABS(2x) — 3
straight line a V-shaped graph a V-shaped graph

3. x=ABS(y) and x = ABS(y/4) 4. y= ABS(XZ) looks the same as y = ABS(x).
are V-shaped and open to the right.
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EQUATION GRAPHER

ANSWERS Worksheet 12: Advanced Techniques - Absolute Value Function (p. 2 of 2)

5a. y=x*- 5and y=ABS(X’- 5)

y = ABS(X® — 5) looks like y = x> — 5, except
the part of the parabola where y is negative

has been flipped around the x-axis.

5b. y=ABS(X*-5) -7

.y = ABS(X*- 5) — 7 is the same shape as
.y = ABS(X¥*- 5), but 7 lower.

6a. y=TAN(X) and y = ABS(TAN(X))

6b. x=TAN(y) and x = ABS(TAN(Y))

7. y=ABS(3TAN(X)) + x

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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Linear & Quadratic Graphs

LINEAR & QUADRATIC GRAPHS

Levels | - - .« - < . . . T
of 10

...................... |'- See "|

Equation: |[( X+2)2/16+Y2/7/36=1| ‘

Teacher’'s Note:

For a monochrome monitor, the target graph will be drawn using dashes, and your graph will be drawn solid, so you
can tell them apart. This information is included in the instructions shown to students who are using monochrome
monitors.

Overview
Grade Level: 8 - adult
Prerequisite Skills: an introduction to linear and quadratic graphs
Type: practice in relating equations to graphs

Description

Students choose the type of linear or quadratic graph to be used: line, parabola,
circle, ellipse, or hyperbola. A graph is displayed on a coordinate grid. Students enter
equations to match the target graph shown.

The graph of each equation entered is plotted on the screen in a different color

from the target graph. (On a monochrome screen, the target graph is dashed, and the
student’s graphs are solid.) Students continue entering equations and observing their
graphs until the equation matches the target graph.

Objectives
1. to recognize basic shapes of linear and quadratic graphs
2. to relate graphs to their equations
3. to translate graphs horizontally and vertically
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Linear & Quadratic Graphs

4. to manipulate graphs by altering the corresponding equation

5. to generalize transformation concepts and strategies from simple to
more complex graphs

6. to use guess and check to diagnose errors and revise hypotheses

LINEAR & QUADRATIC GRAPHS Menu Items
Linear & Quadratic Graphs
How to Write Equations

Instructions

Lines
Parabolas
Circles
Ellipses
Hyperbolas

Mixed Graphs

* How to Write Equations

This is the practice screen described under “How to Write Equations® on page 11. Itis
the same for all programs.

* Instructions
These are the instructions shown to students:

Instructions

& target graph will be drawn. You type an eguation to match the
target graph.

Your eguation will be graphed on the same grid as the target graph.
If your equation is wrong, you can see how your graph is different
from the target graph and try again. If you need help, you can

choose to see an answer.

When you get a problem correct on the first try without asking to
see the answer, you move to the next higher level.

The five menu items below lead to practice with the chosen kind of graph.
* Lines

» Parabolas

+ Circles
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Linear & Quadratic Graphs

* Ellipses
* Hyperbolas

If you choose Hyperbolas, you will be asked whether you want hyperbolas
like x?/4-y?/9=1 or hyperbolas like xy = 4.

You will then see a dialog screen (headed by the type of graph you selected) where you
specify the difficulty level you want. Lines and Parabolas each have difficulty levels 1
(easiest) through 20. Circles, Ellipses and Hyperbolas each have levels 1 through 10.
You can click on one of three radio buttons to set your level:

o Begin with easy problems and work up to hard ones
o Choose a starting level and work up from there
o Practice problems of mixed difficulty

“Beqgin with easy problems...”

This starts at level 1 and moves up one level when you enter a correct
eguation on your first try, without clicking the See Answer button. Your
current level is shown on the graphing display (e.g., “level 1 of 20”). When
you are correct at the top level on your first try, the program congratulates you
and waits for you to select from the menu bar.

Most levels include several similar graphs, but a few levels contain only one
graph. For example, Level 6 for parabolas includes the graphs y = - (x - 1)?,
y = - (x - 2)* and so on, but Level 1 is always the graph y = x°.

"Choose a starting level..."

This is like "Begin with easy problems..." except that you set the starting level.
“Practice problems of mixed difficulty®

This selects problems randomly from all difficulty levels for the type of graph
you selected. The level is not shown on the graphing display, and the
sequence of problems is not affected by whether you are correct on your first
try. This section does not end.

» Mixed Graphs

This menu item provides practice with randomly selected types of graphs at randomly
selected difficulty levels. First, you see a dialog screen where you mark checkboxes to
specify the types of graphs you want to practice (you can mark one or several):

Lines

Parabolas

Circles

Ellipses

Hyperbolas (both kinds)

On the display grid, the program presents one of each type of graph you marked (in
random order, at a randomly selected difficulty level). The program then generates a
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Linear & Quadratic Graphs

new random order for the types of graphs you selected and presents a randomly
selected difficulty level of each graph type. The sequence of problems is not affected
by whether you are correct on your first try. This section does not end.

Graphing Display Features and Buttons

The coordinate grid is -10 < X <10 and -8 <Y <8. When the mouse is over a grid
point, the grid coordinates of that point are displayed at the bottom of the screen.

The target graph is drawn in one color, incorrect answers are drawn in a second color,
and a correct (or “close enough”) answer is drawn in a third color. (On a monochrome
screen, the target graph is drawn dashed, and all other graphs are drawn solid.)

In LINEAR & QUADRATIC GRAPHS, the equations you enter must be in a form which uses X
and Y at most once each.

If your graph is exactly correct, the program says “Right.” If your equation is not exactly
correct, but it is the correct type of graph and is within a few screen dots of the target
graph, the program says “Close enough” and continues as if you were correct. If your
graph is not close enough, it remains on the screen. You can compare it with the target
graph, edit your equation, and try again.

See Worksheet 13 — Instructions and Tips for details on using this program.

- Graph ‘

‘M After entering an equation, click this button to graph the equation. If there
is no equation entered, or the entered equation has just been graphed, this button will
be inactive. If the equation cannot be evaluated, a diagnostic message will be
displayed when this button is clicked. The color of this button indicates that pressing
the Return key is equivalent to clicking this button.

Remowve
|

\.Old Graphs J cjick this button to erase the incorrect graphs on your display.
| - See |
\Answer_J ¢ you click the See Answer button, one possible answer will be shown at
the bottom of the screen. You still must enter a correct equation to move on to another
problem. If you are on a display where the difficulty level is shown, that level will not

increase if you answer a problem correctly after clicking the See Answer button.

| ' Show '

\ASYmPpIotes J rpere is an additional button labeled Show Asymptotes on displays

where the target graph is a hyperbola. Clicking this button will draw the asymptotes in
gray. On displays where the difficulty level is shown, you can click Show Asymptotes
and still move up one level if you are correct on your first try.
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Linear & Quadratic Graphs

Ideas for Classroom Use
Before Students Use the Program

Students should have seen the basic equations and corresponding graphs of the types
they will use on the computer. For example, the program section on parabolas should
accompany or follow a unit of study on parabolas, and students should be familiar with
the equation y = x* and its graph.

Use the EQUATION GRAPHER program to play “what if” for the type of equations under
study. For example, graph the equation y = x?, then ask “what if there were a minus
sign before the x* term?” Graph y = - x* and observe the results. Another example
would ask “what if x were replaced by (x+2)?” Graph this equation and observe the
changes.

Demonstrate LINEAR & QUADRATIC GRAPHS to the class, using example problems such
as those on the sample classroom demonstration on page 51.

Distribute copies of Worksheet 13 - Instructions and Tips to the students.

Using the Program

Encourage students to begin with easy problems, to use guess and check problem
solving, and to persevere. Point out that “mistakes” can be valuable learning
experiences in this activity. Often the graph of an incorrect equation provides important
clues to the correct equation. Discuss the information obtained by comparing its graph
to the target graph. Remind students that their goal is to develop general strategies that
can be applied to many types of graphs, rather than memorize formulas.

Ask students to use Worksheet 14—Recording Sheet to keep track of their progress.

Follow-up

Encourage students to generalize their results. How does the equation change
if the graph —

is moved up or down on the grid?
is moved to the right or left?
is “upside down” or slanting down?
is steeper or flatter?
Play GREEN GLOBS Novice game.
Play TRACKER Novice game, using the type of graphs practiced in this program.
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Sample Classroom Demonstration on Parabolas

Linear & Quadratic Graphs

On the screen displays for this example, the target graph is dashed, as it would be on a
monochrome monitor. On a color monitor, the target graph will be solid but a different

color from your graphs.

Note that your examples may differ slightly from these.
Be open to suggestions and ideas from the students,
even if they might take you off the track of the planned
demonstration.

Here is a graph of some equation. We need to figure out
what the equation is. (If you choose a starting level of 5,
you will see a problem similar to this one.)

We know it is a parabola, so we can start with the basic
equation for a parabola, y=x°. Let’s graph that equation for
comparison.

Looking at the graphs we see that the target graph is shifted
to the right 3 units from the origin. Let’s experiment. What if
we added 3 to the x? term in the equation? y = x*+ 3

Let's graph y = x*+ 3 and see.

Well, that’s not what we want. It moved the parabola up, not
to the right. What else could we try? Let’s try using x+3 in
place of x

y = (x+3)°
and graph that.

That's not it, either! This time the graph is shifted to the left
by 3. The form of the equation is right but the direction is
wrong, so let’s change from +3 to -3.

y = (x-3)?
That works!

Green Globs and Graphing Equations
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Linear & Quadratic Graphs

Here’s another target graph (shown dashed ). We know it's
a parabola, but it's upside down (inverted). What can we
change in the equation y = x? to invert the graph? Try

changing from + x* to — x°. EEEER iiseid
y=-x*

That works.

Now how can we move that inverted parabola down three !

units? We need to subtract 3 from the expression used to e
determine Y, so try :
y=-x°-3 /:\

Graph it. That’s it! L LAY

Here’s another target parabola (dashed), so we’ Il start with 1

y = x% again. Its vertex is at the origin, but it's higher at each BERREREIGS DaDoa dane

x value than the basic parabola.

It appears to be 4 times higher at each x value (e.g., (1,4) is
on the graph instead of (1,1)). T

Let’s try multiplying the function by 4. I'ué/
y:4X2 -....:...- b
That's it. I

Here is a parabola that is “going sideways.” How couldwe  |:::: o1 0

change the basic equation to match this graph? RS SRR

Switch the x and the y.
x =y’

How could we combine several of these ideas to find the
equation of almost any parabola?

Green Globs and Graphing Equations 52



Linear & Quadratic Graphs

LINEAR & QUADRATIC GRAPHS Worksheets for Students - Overview

Worksheet 13 summarizes the instructions students see in the program and suggests
some problem-solving strategies to use.

Worksheet 13: Instructions and Tips (page 54)

Worksheet 14 provides a form where students can record the types of graphs and levels
of difficulty they have completed.

Worksheet 14: Recording Sheet (page 55)
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LINEAR & QUADRATIC GRAPHS
Worksheet 13: Instructions and Tips

A graph is displayed on a coordinate grid. Your job is to enter an equation that matches
that graph. The equation you enter is plotted in a different color on the same grid.
Compare your graph with the original graph, analyze the differences, and modify your
equation as needed.

You may enter as many equations as you like until you match the original graph.
You can choose the type of graph:
straight line
parabola
circle
ellipse
hyperbola
a mixture of your choice
You also choose
1. to begin at the easiest problems
2. to begin at more challenging problems, or
3. to work problems of mixed difficulty levels.

Start with option 1. If you leave the program before finishing, record your current level
on your recording sheet. The next time you use the program, choose option 2 and start
at the level you recorded. You will advance to the next level of difficulty when you
match the target graph on your first try without clicking the See Answer button. When
the target graph is a hyperbola, you can click the Show Asymptotes button and still
advance one level if you are correct on your first try.

Tips for Success
Use these problem-solving strategies:

Simplify the Problem -- Start with the basic equation of the type of graph (for example,
y=x* for a parabola).

Divide and Conquer -- Break the problem down into smaller parts. If the graph shifted,
inverted, stretched, or squeezed, change the basic equation for each of these one at a
time.

Guess and Check -- Make your best guess for the equation, then carefully compare its
graph and the target graph. Then improve your equation to make a better guess on
your next try.

Do not try to memorize formulas for every graph!
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LINEAR & QUADRATIC GRAPHS
Worksheet 14: Recording Sheet

Circle the numbers to show the levels you complete.

Type of Graph Used Level Completed

straight line 1 2 3 45 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20

parabola 1 2 3 45 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20

circle 1 2 3 4 5 6 7 8 9
ellipse 1 2 3 4 5 6 7 8 9
hyperbola 1 2 3 4 5 6 7 8 9
like x* - y* =1

hyperbola 1 2 3 4 5 6 7 8 9
like xy =1

mixed graphs number of problems completed

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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Green Globs

GREEN GLOBS

- R R

Restart |
Came

| Remove |
Old Graphs

. | Undo |
Last Shet

( Graph ]
Equation

YuurShut:|Y=—'I+(X+'I)2/E|+.E|/(X+E|) ‘

Overview
Grade Level: 8 - adult
Prerequisite Skills: introduction to graphing equations
Type: strategy game using graphing concepts

Description

Thirteen randomly scattered green globs are displayed on a coordinate grid. The
students’ goal is to explode all the globs by hitting them with the graphs of equations
entered at the keyboard. The scoring algorithm encourages students to hit as many
globs as possible with each equation. The top ten Novice Game scores and the top ten
Expert Game scores are recorded along with the games that produced them. Students
can review these games to learn strategies to apply to future games. You can have
different groups of students in different records files — see the section “Using More
Than One Records File” on page 87.

Objectives

-

. to apply skills in relating equations to their graphs

2. to construct equations to fit specified criteria

3. to discover and explore relationships between equations and their graphs
4. to create strategies to maximize the number of hits per equation

5. to transform basic graphs by modifying their equations

6. to work cooperatively in a group

7. to explore types of equations not found in standard texts
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Green Globs

8. to strengthen skills in problem solving: guess and check, simplify, and divide
and conquer

9. to apply graphically a wide range of algebraic concepts and techniques

GREEN GLOBS Menu Items

Green Globs
How to Write Equations

See Novice Game Rules
Start a Novice Game
See Novice Game Records

See Expert Game Rules
Start an Expert Game
See Expert Game Records

v Sound On
Sound Off

* How to Write Equations

This is the practice screen described under “How to Write Equations” on page 6. Itis
the same for all programs.

* See Novice Game Rules

These are the instructions shown to students, on several screens. Buttons (not shown)
at the bottom of each instruction screen allow students to navigate back and forth
among the screens.

—Novice Game Rules :
. . . 4 .
. - .4 .
@ @ T The object of this game is to hit as many green globs
S I as possible with each shot. The game ends when all
o the green globs have been hit.
———+—+—}0— +— }
S (P Score
B T Your score for each shot is:
+ - - - - - - - ® - - 1 point for the first glob hit on that shot
P 2f|:|r thE SECDnd
@ T @ 4 for the third
T @ B for the fourth
S S 16 for the fiftn
There are some green globs on the grid. ... and so on.
You shoot at the globs by writing
equations for the computer to graph.
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Types of Graphs
‘You can use lines, parabolas, circles, ellipses, and hyperbolas.

For example:
¥ =3 2X+Y = 3 X=1/3v<
X=-6 XE+¥E = G4 3(%-112-4(¥-2)€ = 50

‘fou can do other kinds of graphs if you write them as either:
¥ = an expression in X, for example: ¥ = 3x3-2x<
or X = an expression in Y, for example: X = IyE-5,/(y-4)4

Exponents

Exponents are limited to one digit.

To write an exponent (as in XZ), type the A key, then type the exponent.

Special Functions
You can also use these functions: abs, sgr, log, exp.

abs means absoluie value .
sQr means sguare root.
log means natfural log, the inverse of the exponential function exp.

Parentheses
Use parentheses around function arguments. Write abs(2X), not abs2X.

Trig Functions
Trig functions are not allowed in the Novice Game.

Saving a Game
To save your game, select 'Save...' from the File menu. Saved games
can be continued later by selecting 'Open...' from the File menu.

Undo
To take back one or more shots, click the Undo Last Shot button.
It will undo another shot each time you click it. (A shot that
hits no globs is erased automatically on your next shot.)

If a shot doesn't do what you want, you do not need to click the
Undo Last Shot button immediately. You can leave the graph on
the screen while you make changes to your equation, then click
Undo Last Shot, then click Graph Equation.

» Start a Novice Game

Green Globs

This goes directly to the Novice Game display, which is a coordinate grid with

-10= X< 10and -8 < Y < 8. Thirteen green globs are scattered randomly on the grid,
in a different arrangement for each game. You enter an equation, the graph of your
eqguation is drawn, and any green globs which the graph hits will explode and disappear.

Strategies and graphing techniques will apply from one game to another, but specific
equations will not, because the arrangement of green globs is different for each game.
When you finish a game (by hitting all the green globs), the program compares your
game score to those in the GREEN GLOBS Novice Game section of your Records file. If
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Green Globs

your score is higher than the lowest score currently in the Novice Game section, or the
Novice Game section has fewer than ten scores saved in it, you will be offered the
opportunity to add your game to the Records.

A game added to the Records will be erased when it is no longer in the top ten scores
for that game. To save a game permanently, use the Save... option described below
and/or see the section titled Using More Than One Records File on page 87. When your
game is eligible for the Records, you will be asked if you want to add your game to the
Records. If you accept, you will be asked to enter your name(s), and you can type any
string up to 40 characters which fits within the bounds of the text entry box. (See
TEACHER OPTIONS on page 79 for tools teachers can use to change these typed names.)
The program then adds the name, score, date, and game to the Records.

In the File menu, Save... is available while playing a game. Saving a game saves all
the information necessary to continue the game at another time. Save... uses the
standard Macintosh dialog, where you indicate the disk drive and folder and enter a file
name.

To resume a saved game, select Open... from the File menu. (Open... is available after
you select GREEN GLOBS from the Programs menu, while you remain in the GREEN
GLoBs program.) Open... uses the standard Macintosh dialog. Any user can open and
continue any saved game if the user can access the file where the game was saved.

A file containing a saved game can be moved, renamed or deleted in the Finder like
other Macintosh files. The TEACHER OPTIONS provide management tools only for
Records files, not for files containing saved games.

A game can be saved at any stage, including the “finished” stage. To determine
eligibility for inclusion of a game in the Records, the score of a finished game (including
an opened game which had been saved at the “finished” stage) is compared to the tenth
score of the records section in the current Records file, not the Records file the user had
when the game was saved.

If you want to include in the Records a game whose score does not qualify for the
Records, the player can save it using Save..., then Open... the saved game file at a later
time — after you have deleted some games from the Records file or created more
Records files. (The TEACHER OPTIONS chapter on page 79 explains how to do both of
those.)

* See Novice Game Records

This shows a display of the name, date and score for each of the ten highest scoring
GREEN GLOBS Novice games. (The TEACHER OPTIONS chapter on page 79 provides
tools for managing these records.) You can select a game with the mouse to watch a
shot-by-shot replay of the game. After each shot is replayed, you can click a button to
see the next shot, or a button to cancel watching the replay and return to the display of
record scores and names.

For a user who has started Green Globs & Graphing Equations with more than one
records file (see page 87 for how to set this up), the menu item

See Novice Game Records
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is replaced by the following two menu items:
See Novice Game Records for your group
See Novice Game Records for another group

The first item shows records in the file where the user’'s own record-qualifying games
will be added; the second item offers a choice of other Records files to look at. The
user can select one of the other Records files and watch replays of games in that
Records file.

» See Expert Game Rules
These are the instructions shown to students:

Expert Game Kules

The rules for the Expert Game are the same as the rules for the
Movice Game, with these additional features:

shot Absorbers
There are five shot absorbers, which stop any shots that hit them.

Functions
The Expert Game allows these functions:
abs, sgr, log, exp, sin, cos, tan, csc, sec, cot, atn{arctangent).

Parentheses
Use parentheses around function arguments. Write sin(2X), not sin2Xx.

Bi
To make the symbol i (pi), type the letter p.

« Start an Expert Game

The display for an Expert game looks and operates like the display for a Novice game,
except that the grid also has five shot absorbers and trig functions are allowed.

» See Expert Game Records

The top ten GREEN GLOBS Expert Game record scores are kept independently of the
GREEN GLOBS Novice Game records. (The TEACHER OPTIONS provide tools for
managing these records — see page 80.) For a user who starts Green Globs & Graphing
Equations with more than one records file (see page 87 for how to set this up), the
menu item

See Expert Game Records

is replaced by the following two menu items: (see the description under See Novice
Game Records)

See Expert Game Records for your group
See Expert Game Records for another group
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e Sound On
* Sound Off

The sound feature makes a sound when a glob is hit (a medium-pitch tone) or a shot
absorber is hit (a lower-pitch tone). Teachers can specify whether users are allowed to
switch sound on and off, and whether sound is initially set to on or off. See the TEACHER
OPTIONS section Change Sound Settings on page 82. The initial sound settings allow
users to switch sound on and off, with sound initially on.

When users are allowed to switch sound on and off, the last two menu items on the
GREEN GLOBS menu will be Sound On and Sound Off, with a check mark next to the
current setting. To change the setting, select the setting you want from the menu. The
change remains in effect until you change it or select Quit from the File menu.

When users are not allowed to switch sound on and off, Sound On and Sound Off are
removed from the menu, and the sound status remains at the initial setting specified in
TEACHER OPTIONS.

Graphing Display Features and Buttons

When the mouse is over a point on the grid, the coordinates of that point are shown at
the bottom of the screen.

Graph ‘
‘M After entering an equation, click this button to graph the equation. If there
IS no equation entered, or the entered equation has just been graphed, this button will
be inactive. If the equation cannot be evaluated, a diagnostic message will be
displayed when this button is clicked. The extra frame around this button indicates that
pressing the return key is equivalent to clicking this button.

|' Undo

\_Lastshot J 1his putton is inactive (i.e., gray lettering) unless you have one or more

shots (graphs) on the grid. Pressing this button will undo your most recent shot — the
graph will be erased, any globs hit by that graph will be restored to their original un-hit
state, and the score will revert to what it was before the shot was made. Whatever you
have typed in the equation entry box will not be affected. Each successive press of this
button will undo one more shot.

Instead of calculating all the coefficients in an equation before making a shot, you can
make a guess at the general form of the graph you want, click Graph Equation, use the
result to decide how to modify your equation, then click Undo Last Shot. You can then
click Graph Equation to see the revised version of that shot and repeat the Undo -
Revise - Graph cycle as many times as you want. Undo Last Shot does not need to be
chosen immediately — you can leave the graph on the screen until you have finished
revising the equation, then click Undo Last Shot. If you forget to click Undo Last Shot
before clicking Graph Equation for the revised shot, just click Undo Last Shot twice,
then click Graph Equation.
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If you click Undo Last Shot several times in succession (to undo several shots), you will
notice that the first Undo is instantaneous, but the rest take a few seconds each. The
first Undo Last Shot is fast because it can use a “snapshot” of the grid taken just before
the equation was graphed. The second and successive undo’s are done by redrawing
the graph-to-be-undone in the screen background color, which takes a few seconds.

Remaove

|" Old Graphs J |1 he graphs of earlier shots start to clutter the display, you can click this
button to erase all the graphs on the grid. This does not affect the game in any way,
and in fact the program does not record that the graphs were erased; the graphs will be
redrawn if the screen is refreshed (for example, if you switch to another window and
back) or when Undo Last Shot is clicked once or twice (depending on the situation). If
some graphs are redrawn in those cases and you don’t want them, just click Remove

Old Graphs again.

|' Restart

o Click this button to start the game at the beginning, with the same

arrangement of green globs on the grid and no shots made. When you click this button,
a dialog box will ask “Do you want to restart this game?” If you click Cancel, the game
continues unaffected. If you click OK, the game irrevocably restarts, erasing all your
previous equations and whatever is in the equation entry box. If you want to keep what
you have typed in the equation entry box, double-click your equation to select it all, then
select Copy from the Edit menu. Then click Restart Game and select Paste from the
Edit menu.

Ideas for Classroom Use
Before Using the Program

If a new class is starting to use the program at a lower experience level than the
previous class which used the program, teachers may want to delete the top ten record
scores or create a new Records file for the new class. The TEACHER OPTIONS section on
page 79 explains how to do these things.

Students should have had practice in writing equations for graphs. The program LINEAR
& QUADRATIC GRAPHS and the utility EQUATION GRAPHER may be used as preparatory or
concurrent activities. The TRACKER game also provides useful experience in
manipulating equations and graphs.

Teachers should understand that GREEN GLOBS is a challenging game that may require
a considerable amount of time and mathematical experimentation. They should allow
students to play the game over a period of days or weeks. GREEN GLOBS can be
fascinating and highly rewarding. Students of all mathematical ability levels can gain
satisfaction and new insights. Students will strengthen their problem-solving skills as
well as learn significant mathematical concepts. Students are encouraged to share their
ideas with each other. Reviewing the top ten games stored in the records is one way to
share discoveries. Working in groups of two or three students can also increase the
exchange of ideas.

Green Globs and Graphing Equations 62



Green Globs

Using the Program

Groups of two or three students often work well. However, some students, especially
the more advanced students, may prefer to work independently. Students should be
encouraged to develop their own strategies. Teachers should not routinely give
students strategies to try. Students should be encouraged to share their ideas and to
build on and apply others’ ideas to their own situations.

Worksheets 7 and 8 (pages 31 - 35) in the EQUATION GRAPHER section of this guide
provide ideas that may be useful in GREEN GLOBS.

Worksheets 9 through 12 (pages 36 - 45) in the EQUATION GRAPHER section of this guide
present several advanced techniques and are intended for students who have
considerable experience with GREEN GLOBS.

The following are examples of strategies students have developed using GREEN GLOBS:
General Math (9th Grade)

Students used horizontal and vertical lines. The first strategy was to use lines that
would hit two globs when possible and to be careful not to hit either of these globs
singly with an earlier shot. After viewing top score games done by algebra students,
they began experimenting with curved graphs using equations like those they saw in the
top score games.

Algebra — Using Roots of Equations

Students who can factor binomials and relate the factors to roots of the equations can
discover that the graphs of y = (x+5) (x-2) or y = x*+3x - 10 will cross the x axis at -5 and
2. They may be able to extend this idea to higher order polynomial equations, such as
y = (X+5) (x-2) (x-7).

EQuATION GRAPHER Worksheet 7 provides discovery activities and practice with this
strategy. The following example builds a polynomial from roots, then uses coordinates
of a target glob to determine appropriate coefficients for the equation. EQUATION
GRAPHER Worksheet 8 (page 33) guides students through this process.

\'uurSth:‘X=(Y—ﬁ)(‘l"+|)(‘l"+?)!30 ‘

Write the equation of a graph that will cross the y axis at 6, -1, -7.
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x = (y-6) (y+1) (y+7)

Use the glob at (-4, 3) to figure a scaling factor. Lety = 3.

X = (3-6) (3+1) (3+7) = (-3) (4) (10) = -120

When vy is 3, we want x to be -4, not -120, so multiply the expression by (-4/-120), which
equals 1/30.

x = ((y-6) (y+1) (y+7))/30

This strategy may lead to the creating of “super-stretched” polynomials. These are
eqguations built in factored form with many roots and a numerical factor included to
stretch the graph. If the numerical factor is large enough, the parts of the graph
crossing the screen are a set of nearly vertical (or horizontal) lines. “Super-stretched”
polynomials must be carefully constructed, since the screen space available for writing
factors is limited.

Math Analysis — Adding Terms of the Form 1/(x - a)

Adding a term of the form 1/(x - a) to a function creates a discontinuity at x = a. While
students at the pre-calculus level may not have studied discontinuities, they can see
through experimentation that the graph of the equation rises (or falls) sharply to the left
and right of the point (a,0). Thus the graph may hit globs that are almost above (or
below) that point.

your Shot: [Y=.13(X+2)2-7+1/(X-3.5)2

Note that for most values of x, the term 1/(x - a) is very small, so it has a negligible
effect on the graph, except where x is close to a.

Interesting graphs can result from adding several of these fractional forms together to
produce discontinuities at several points.

EQUATION GRAPHER Worksheet 9 (page 36) provides discovery activities and practice in
using this strategy.
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Math Analysis - Sums of Functions

Although most textbooks do not emphasize sums of functions, except simple cases
such as y = x + SIN (x), the computer’s calculating power makes these types of
eguations easy to explore. The Expert Game allows the use of trigonometric functions.

Here is an example of the sum of a parabola and a sine function. The effect of adding
the sine function is to make the graph cover a wider path, thereby hitting more globs,
while still avoiding the “shot absorbers.”

\'ourShot:‘X=.5(Y+2)2—9+3.58IN(5Y) ‘

EQUATION GRAPHER Worksheet 11 (page 40) provides discovery activities and practice
in using this strategy.

Math Analysis - Absolute Value Functions

Combining the absolute value function with other functions can provide a useful
strategy. For example:

YourShat: | ¥ =- ABSL | .SK+1)+2 | Your Shot: |[Y =ABS( -(X+2)2/7.346) J

EQUATION GRAPHER Worksheet 12 (page 42) provides discovery activities and practice
in using this strategy.
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Worksheet 15 summarizes the instructions students see in the program.

Worksheet 15: Instructions and Tips (page 67)

Worksheet 16 provides a form where students can record a game.
Worksheet 16: Recording Sheet (page 68)
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Worksheet 15: Instructions and Tips
GREEN GLOBS is a strategy game using graphs of equations. Thirteen randomly
scattered green globs are displayed on a coordinate grid.

Your goal is to explode all of the globs. The globs explode when they are hit by the
graph of an equation that passes through them. You enter equations at the keyboard.

Levels of Difficulty

The Novice Game is the best place to start. You cannot use trigopnometric functions in
the Novice game.

The Expert Game is more difficult. You can use trigonometric functions; but there are
five “shot absorbers” displayed on the grid. The shot absorbers stop any graphs that hit
them.

Scoring

For each equation you enter, the first glob hit is worth one point, the second glob is
worth two points, the third is worth four points, the fourth is worth eight points, and so
on.

For example, if you hit four globs with one equation, you scoreis1+2+4+8=15
points.

Equations
Try to hit as many globs as possible with each graph.

You may use equations of the following types:
+ straight lines
+ functions beginning withy = or x =
 equations for conics (such as circles and hyperbolas)
+ functions using square roots or absolute value
 equations using logarithmic or exponential functions
Trigonometric functions can be used only in the Expert Game.

Top Scores and Games

In both the Novice and Expert Games, the top ten scores and the games that produced
them can be shown in the records. After you try a few games of GREEN GLOBS, you may
want to look at the records.
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Worksheet 16: Recording Sheet

On the grid below, sketch the green globs.

Record your successful equations.

Sketch the graphs of successful equations.

Briefly describe the strategies you used.

Your score

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey
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TRACKER

1 graph
still
hidden

X Line
Q) Parabola

Score
50

+ | Forfeit |

e B Lo ~ Switch to
O O | Probe |

Overview
Grade Level: 8 - adult
Prerequisite Skills: ability to write equations to match linear and quadratic graphs
Type: game using strategy and graphing concepts

Description

In the TRACKER game, graphs are hidden on a coordinate grid. Students gather clues
about the location of the graphs by using “probe shots.” These probe shots are
horizontal and vertical lines. Each point where the probe crosses the hidden graphs is
marked on the screen. After using probes to locate a graph, students send a “tracker”
along the graph by entering its equation.

TRACKER includes a Practice section, a Novice Game and an Expert Game. The top ten
Novice Game scores and the top ten Expert Game scores are recorded along with the
games that produced them. You can have different groups of students in different
records files — see the chapter Using More Than One Records File on page 87.
Objectives

1. to relate graphs to their equations

2. to apply transformation concepts to graphs of equations

3. to develop efficient strategies for locating useful points on hidden graphs

4. to generalize strategies for use with many types of graphs

5. to analyze characteristics of various types of graphs

6. to apply geometric properties, such as symmetry
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TRACKER Menu ltems

How to Write Equations

See Instructions
Practice

Start a Novice Game
See Novice Game Records

Start an Expert Game
See Expert Game Records

* How to Write Equations

This is the practice screen described under “How to Write Equations” on page 6. Itis
the same for all programs.

* See Instructions

These are the instructions shown to students, on several screens. Buttons at the
bottom of each instruction screen allow students to navigate to the next and previous
screens. (The buttons the students see are not shown here).

Rules for Tracker

The object of this game is to find the eguations for several hidden graphs.

The hidden graphs may be lines, parabolas, circles, ellipses, or hyperbolas,
but there will be only two types of graphs for a game.

You have two kinds of shots in this game: Probes and Trackers.
You shoot Probes across the screen to get clues about the hidden graphs.

When you think you've figured out one of the hidden graphs, you shoot a
Tracker along its path to see if you are correct.
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Probes and Trackers

A Probe is a horizontal or vertical line like Y =-3 or X = 4. As a Probe goes
across the screen, it marks each point where it crosses a hidden graph.

Graphs of one type will be marked with an %, and graphs of the other type
will be marked with an O. Some of the % 's and O's may overlap.

Depending on where you shoot a Probe, you may hit several hidden graphs
or none at all. A hidden graph will never be a horizontal or vertical line.

You can switch between shooting Probes (when you need clues) and
Trackers (when you think you've found a graph). If you get stuck, you can
forfeit and see the remaining hidden graphs.

Scoring

Probes
Your first Probe costs 1 point, your second Probe costs 2 points,
your third Probe costs 3 points, ...and so on.

Correct Trackers
The points scored for a correct Tracker depend on what kind of
graph it is:

30 points for a line
35 points for a parabola
40 points for a circle
45 points for an ellipse
20 points for a hyperbola
Wrong Trackers
Each wrong Tracker costs 10 points.

* Practice

In the Practice section, you choose the type of graph that is hidden and whether one or
two graphs are hidden. This lets you concentrate on strategies for locating just one or
two hidden graphs of the same type. No score is kept in this section.

» Start a Novice Game

In the Novice Game, you choose two types of graphs to be hidden on the grid. There
are always three hidden graphs: two of one type and one of the other. One type of
graph is marked with X’s and the other with O’s when crossed by a probe shot. If a
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hidden graph is a hyperbola, it could be of either kind and not necessarily the same kind
as another hidden hyperbola.

The pool of possible hidden graphs in TRACKER is the same as the pool of possible
target graphs in LINEAR & QUADRATIC GRAPHS, except that hidden graphs are never
horizontal or vertical lines.

The game ends when you have found all the hidden graphs. When you finish a game
with a positive score, the program compares your game score to those in the TRACKER
Novice Game section of your Records file. If your score is higher than the lowest score
currently in the Novice Game section, or the Novice Game section has fewer than ten
scores saved in it, you will be offered the opportunity to add your game to the Records.

A game added to the Records will be erased when it is no longer in the top ten scores
for that game. To save a game permanently, see the chapter Using More Than One
Records File on page 87. Save... from the File menu is not available for TRACKER
games. (If it were, the Records could be compromised easily — someone could save a
game before making any shots, forfeit to see the hidden graphs and their equations,
open the saved game, and begin the game already knowing the answers.)

When your game is eligible for the Records, you will be asked if you want to add your
game to the Records. If you accept, you will be asked to enter your name(s), and you
can type any string up to 40 characters which fits within the bounds of the text entry
box. (See TEACHER OPTIONS on page 80 for tools teachers can use to change these
typed names.) The program then adds the name, score, date, and game to the
Records.

» See Novice Game Records

This shows a display of the name, date and score for each of the ten highest scoring
TRACKER Novice Games. (See Teacher Options on page 80 for tools to manage these
records.) You can select a game to watch a shot-by-shot replay of the game. After each
shot is replayed, you can click a button to see the next shot, or a button to cancel
watching the replay and return to the display of record scores and names.

For a user who starts Green Globs & Graphing Equations with more than one records
file (see page 87 for how to set this up), the menu item

See Novice Game Records

is replaced by the following two menu items:
See Novice Game Records for your group
See Novice Game Records for another group

The first item shows records in the file where the user’'s own record-qualifying games
will be added; the second item offers a choice of other Records files to look at. The
user can select one of the other Records files and watch replays of games in that
Records file.

» Start an Expert Game

In the Expert Game, the program randomly chooses the two types of graphs, and you
do not know what types of graphs are hidden. You must use probes to determine the
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types of graphs as well as their locations. You choose how many graphs will be hidden
— from three to six. Although higher scores are possible when there are more hidden
graphs, it can be challenging to sort out five or six graphs on the screen. The display
for an Expert game looks and operates like the display for a Novice game, except you
do not know what types of graphs are hidden.

» See Expert Game Records

The top ten TRACKER Expert Game record scores are kept independently of the
TRACKER Novice Game records. (See TEACHER OPTIONS on page 80 for tools to
manage these records.) For a user who has started Green Globs & Graphing Equations
with more than one records file (see page 87 for how to set this up), the menu item

See Expert Game Records

is replaced by the following two menu items: (see the description under See Novice
Game Records)

See Expert Game Records for your group
See Expert Game Records for another group

Graphing Display Features and Buttons
The game display is a coordinate grid with -10< X< 10and -8< Y < 8.

When the mouse is over a point on the grid, the coordinates of that point are shown at
the bottom of the screen. At the upper left, the display shows the number of graphs
hidden (or the number still hidden, if you have found some but not all). The number is
updated each time you find a hidden graph. Below that, in Practice and the Novice
Game, the display reminds you which type of graph is marked with an “X” and which
type is marked with an “O”. In the Novice Game and Expert Game, the score is
displayed at the lower left.

|' Switch to | | Switch to

Tracker Probe _J At the start of the game, you are prompted to enter an
equation for a Probe. You can switch the prompt from Probe to Tracker at any time by
clicking the Switch to Tracker button. When the prompt changes to Tracker, the button
label changes to say Switch to Probe. You can switch between Probe and Tracker as
often as you want.

If you accidentally enter an equation for a Tracker when the prompt says Probe, you will
be told “Probes are horizontal or vertical. If you meant “Tracker,’ click the Switch
button.” Your score is not changed by this.

If you accidentally enter an equation for a Probe when the prompt says Tracker, you will
be told “Horizontal and vertical lines are Probes. For a Probe, click the Switch button.”
Your score is not changed by this.

‘? Graph
“Equation ¥ \\/hen you are prompted to enter an equation for a Probe, you enter an

equation like Y = 3 or X = - 5 and press the Return key (or click the Graph Equation
button). All intersections between your Probe and any remaining hidden graphs will be
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marked with an “X” or an “O”. If your Probe does not intersect any of the remaining
hidden graphs, you will be told “No intersections found on the screen.” If your Probe is
off the screen (like Y = 20), you will be told “This Probe is off the screen.” The cost of
the Probe will be deducted from your score, even if it is off the screen or intersects no
hidden graphs.

When you are prompted to enter a Tracker, you enter an equation for a hidden graph
and press Return (or click the Graph Equation button). The graph of your equation is
drawn and your score is updated. If your Tracker was correct, it will remain on the
screen. If your Tracker was not correct, it will remain on the screen until your next
Tracker, to help you decide where you need to send Probes. If your Tracker is not
correct, but it is the correct type of graph and is within a few screen dots of the correct
graph, you will be told that it is “close enough” and it will be scored the same as a
correct Tracker.

Forfeit
|" "| Click the Forfeit button if you want to give up. If you click Forfeit, a
dialog box will ask “Do you want to forfeit this game?” Click Cancel to continue the
game, or OK to forfeit. If you click OK, the remaining hidden graphs will be drawn and
their equations shown at the lower left of the grid. A forfeited game is not eligible for the
Records, regardless of its score.

Ideas For Classroom Use
Before Using the Program

If a new class is starting to use the program at a lower experience level than the
previous class which used the program, teachers may want to delete the top ten record
scores or create a new Records file for the new class. The TEACHER OPTIONS chapter
on page 79 explains how to do these things. The EQUATION GRAPHER program can
provide introductory activities in graphs of equations. Worksheets 1 through 6 (pages
15 - 30) in the EQUATION GRAPHER section of this manual are preparation for playing
TRACKER. The LINEAR & QUADRATIC GRAPHS program is recommended preparation for
playing TRACKER. The graphs used in TRACKER are chosen from the same pool as
those in LINEAR & QUADRATIC GRAPHS . The evaluation of equations is the same, i.e., an
equation which is “close enough” in one program is also “close enough” in the other.

Distribute copies of TRACKER Worksheet 17—Instructions and Tips. This sheet
explains how to play TRACKER and describes the scoring system. Demonstrate one
Practice section and one Novice Game of TRACKER with the class, so that students
understand the process of using probes and trackers. Use their ideas in the
demonstration. Emphasize the guess and check strategy and point out the advantage
of carefully analyzing the information gained from probes and any incorrect trackers.

Use the TRACKER Worksheet 18—Sample Problem in addition to the demonstration or
as a substitute if necessary. It provides an introduction to some types of problem-
solving thinking that students use in playing the game.
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Using the Program

Distribute copies of the TRACKER Worksheet 19 Recording Sheet for students to use to
record their activities. Encourage students to plan strategies and to share and reuse
successful strategies. After students have played the game several times, discuss their
strategies in either large or small groups. If students seem to become discouraged,
subtly aid them by asking relevant questions to help them find a new approach. Here
are some examples of the kinds of strategies students may develop. Avoid telling
students these or other strategies. The problem-solving process of developing
strategies is a most important part of the activity.

If the sides of a parabola have been located, how can the vertex be found? Try
using a probe halfway between the sides, along the axis of symmetry.

What are the key points of a circle? If a probe has crossed a circle, what
additional probes are necessary to determine the center? Does it matter whether
some of the circle is off the screen?

Is the slope of a line more accurately computed from points that are close
together or far apart?

Are four points sufficient to determine two straight lines?

Remind students to apply the transformation skills used in LINEAR & QUADRATIC GRAPHS
-- to start with the basic equation and modify it as needed.

If students need to end a game before they find all the hidden graphs, they can forfeit by
clicking the Forfeit button.

TrRACKER Worksheets for Students — Overview

Worksheet 17 summarizes the instructions students see in the program.
Worksheet 17: Instructions and Tips (page 76)

Worksheet 18 provides an introduction to some types of problem-solving thinking
students use in playing the game.

Worksheet 18: Sample Problem (page 77)

Worksheet 19 provides a form where students can record a game.
Worksheet 19: Recording Sheet (page 78)
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Worksheet 17: Instructions and Tips

TRACKER is an equation-graphing game. Graphs are hidden on a coordinate grid. You enter their
equations to “track” them.

You get clues to the graphs’ locations by using probe shots. Probe shots are equations of horizontal or
vertical lines. When a probe shot crosses a hidden graph, it marks that point with an X or an O.

The types of graphs you choose include the following:
* straight line

» parabola

« circle

* ellipse

* hyperbola (two kinds)

There are three levels of difficulty:

Practice is a good place to start. You choose the type of hidden graph. Either one or two graphs
are hidden on the grid. No score is kept.

Novice Game allows you to choose two types of graphs. Three graphs are hidden on the grid (two of
one type and one of the other). One type of graph is marked by X’s and the other by O’s
when hit by a probe. When you have enough clues, you send a tracker along the graph
by entering its equation.

Expert Game chooses the two types of graphs at random, so you’ll need to discover what type they are
as well as where they are! You choose how many graphs are hidden, from three to six.

Scoring

You score points for correctly tracking each graph:

Graph Type Points Scored
straight line 30 points
parabola 35 points
circle 40 points
ellipse 45 points
hyperbola 50 points

You lose points for each probe and for incorrect trackers:
Action Points Lost
first probe 1 point
second probe 2 points
third probe 3 points

..and so forth
incorrect tracker 10 points

The top ten scores are stored in the records. Scores are kept separately for Novice and Expert Games.
Games that are forfeited and scores of zero or less are not eligible for the records.
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Worksheet 18: Sample Problem

Here is an example of one type of problem you
might encounter in TRACKER. The questions are
the kind you will want to ask yourself when you
work similar problems.

You have chosen parabolas and straight lines.
There are three graphs in all.

The first probe is
y=3.
It hits graphs at several points.

One type of graph is marked with X,
the other type with O.

Which type is marked with O in this game?
(Since the hidden line(s) cannot be horizontal in
this game, it must be parabolas that are marked
with O.)

Do the parabolas open up or down?
Which two points do they pass through?

Try another probe. Where should it be? It could
be another horizontal line, either above or below
y=3.

Tryy=-4.

It looks like one parabola opens down. Try to
locate the vertex. Use a vertical probe through
the parabola, halfway between the sides.

Try x =-3.
The vertex must be at (-3,5).

The X marked at (10,- 4) marks a second point
on the hidden line graph.

Now write an equation for the parabola you
found. Send a tracker by entering that equation.

You need to write an equation for the line, also.

Finally, you will locate and track the other
parabola, using methods similar to those above.

O X

Froge: Y = - 4
.- .0. — -
- -®- - -1 0X- -0 :
e [ i Z
et . . ol
0 O X

sl
Prsbe: K = - §

Tracker: Y =

(Xe3)2,2e5

Copyright © 1996, 2008 by Sharon Dugdale and David Kibbey

1



TRACKER

Worksheet 19: Recording Sheet

Practice Section

Mark the types of graphs you practiced finding.
One Graph

straight line

Two Graphs

parabola

circle

ellipse

hyperbola

Novice Game
1. Choice of graph types

Score

Strategies used

Number of probes used

2. Choice of graph types

Score Number of probes used

Strategies used

Expert Game
1. Number of graphs

List of graphs discovered

Score Number of probes

Strategies used

Number of Trackers

2. Number of graphs

List of graphs discovered

Score Number of probes

Number of Trackers

Strategies used
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Teacher Options

TEACHER OPTIONS

Overview

Two of the programs, GREEN GLOBS and TRACKER, record the highest scoring games
and the names of the students who played them. The TEACHER OPTIONS allow teachers
to manage these records. The TEACHER OPTIONS section is protected by a password to
prevent unauthorized deletion or changing of the data. You need to keep the password
confidential. For instructions and discussion about passwords, see the description
below for menu item Change the Passwords of this Records File on page 81.

NOTE: For security reasons, the TEACHER OPTIONS window closes automatically when
you move to another window or switch to another application.

These are things you can do in TEACHER OPTIONS:

» See replays of selected games

+ Change name or date on selected games

* Delete selected games

» Copy selected games from one Records file to another Records file
» Set passwords to control access to the Records file

+ Set the title for the Records file

+ Set sound on or off

» Create new Records files

* Make lists of Records files and save them as List files

Records Files

The names of the Records file(s) with which you started the Green Globs & Graphing
Equations application are the ones in effect each time you start TEACHER OPTIONS and
when you leave TEACHER OPTIONS to go to another program — regardless of anything
you do with other Records files while in TEACHER OPTIONS. For example, if you choose
to look at another Records file in TEACHER OPTIONS, and then you leave TEACHER
OPTIONS to play a GREEN GLOBS Novice Game, the Records file in effect for you in
GREEN GLoBsS will be the Records file you started Green Globs & Graphing Equations
with, not the Records file you last dealt with in TEACHER OPTIONS.

A Records file contains four sections:
* GREEN GLOBS Novice Game

* GREEN GLOBS Expert Game

* TRACKER Novice Game

* TRACKER Expert Game
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Each section holds the ten highest scores recorded for that game. Each score is
accompanied by the player's name(s), date, and the shots used by the player(s) to
obtain that score.

A Records file also contains a title you specify and the passwords you set to restrict
access to TEACHER OPTIONS for that Records file.

After the menu item descriptions, there is a chapter Using More Than One Records File
on page 87 that includes an example showing how to create a List of Records files.

TEACHER OPTIONS Menu ltems

Teacher Options

See or Change Creen Globs Novice Game Records
See or Change Green Globs Expert Game Records

See or Change Tracker Novice Game Records
See or Change Tracker Expert Game Records

Change the Title of this Records File
Change the Passwords of this Records File
Change the Sound Settings for users of this Records File

Choose a Records File from your current list
Choose a Records File from a disk directory
Choose a List File [list of records files] from a disk directory

Create a new Records File
Create a List of existing Records Files
Edit or Save your current List of Records Files

Editing Record Games

» See or Change GREEN GLOBS Novice Game Records
» See or Change GREEN GLOBS Expert Game Records
+ See or Change TRACKER Novice Game Records

» See or Change TRACKER Expert Game Records

The four menu items listed above go to a display where you can rename, delete, copy

or see replays of record games. The display shows the score, name and date for each
of up to ten games. Start by selecting one or more record games, then click one of the
following five buttons.

| See Replay

ofCame J This jets you watch a shot-by-shot replay of each of the selected

games. After the completion of each replayed game, there will be a button labeled Next
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Game. There will always be a button labeled Cancel Replay which returns immediately
to the list of record games. The replay you see is the same as the replay option
available to students in the respective games; it is included here for convenience.

|' Change

\Name or Date / g |ets you edit the name and date associated with each record

game. Text edit boxes show the space limits. Any characters are allowed. If you do
not want a date displayed, just erase it and leave its text edit box blank. If you selected
more than one record game before clicking this button, the selected records’ names and
dates will be presented one at a time for editing.

| : Delete )

i This deletes all the selected record games — their names, scores,

dates and shots. A caution warning dialog box will ask for confirmation; click Cancel to
return to the Records display with no changes. If you click Delete in the warning dialog
box, the deletion is done. Deletions are permanent; there is no undo option for them.
To reinitialize a Records section (to start over with no record games in that section),
select all record games and click the Delete button.

|' Copy to | | Paste from |
. Another File . Another File

" If you select one or more records and click Copy to
Another File, all the information about those records is copied from the current Records
file into an area of the program’s computer memory (the records in the Records file are
still there, unchanged). You can then move to another Records file (if you know its
password) and click Paste from Another File to add them to that Records file. If the
number of records you paste would overfill that records section (the limit is ten games),
then only the highest ten scores will be saved and a message will tell you if some of
your games were not added. Clicking Paste from Another File does not remove the
information from the program’s computer memory, so you can move to yet another
Records file (or create new Records files) and paste the information there, also.

Change the Title of this Records File

For each Records file, you can specify a title to be displayed when the record games in
a Records file are displayed. The title can be up to 61 characters and you can change it
at any time. You do not need to give a Records file a title, but if you have more than
one Records file, users will find titles helpful.

In TEACHER OPTIONS, the password entry screen display and the Records screen display
include both the Macintosh file name and the title (if any) of the Records file you are
currently dealing with. The screen displays where students see Records show the title
(if any) you have assigned. They show the Macintosh file name only if the students are
dealing with more than one Records file and the files have not been assigned titles.

Change the Passwords of this Records File

Each Records File has both a password and a master password kept in it. Each time
you enter TEACHER OPTIONS for that Records file, you will be asked to type the
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password. (In this program, you can ignore capitalization when typing your password:
frog = FROG.) If your typed password matches the password, you will be allowed
access to TEACHER OPTIONS for that Records file, and you will be allowed to change the
password.

If your typed password matches the master password, you will be allowed access to
TEACHER OPTIONS for that Records file, and you will be allowed to change both the pass-
word and the master password. If you enter TEACHER OPTIONS by typing the password,
and you try to change a master password which already has been set, then you will first
be asked to type the current master password.

The master password is convenient for a support person (e.g., a technology coordinator
supporting teachers or a teacher supporting a student teacher). If the password is
forgotten, or a user learns the password and changes it, the master password will allow
access to fix things.

In the distribution folder, you will find one Records file (“Globs/Tracker Records”), on
which the password and master password are blank. When the password is blank, the
first person to choose TEACHER OPTIONS for that Records file will be asked to set the
password. When the master password is blank, it is ignored. (But if the master
password is blank, anyone who matches the password can set the master password.) If
you received the disk from someone else (like a technology coordinator), ask if a
Records file was created for you and/or the password or master password was set.

If you forget the password (or someone learns it and changes it), your alternatives are:
* Find someone who knows the password
» Find someone who knows the master password
» Replace the Records file with a new Records file

If you are your own support person for this software, you can do several things:

» Keep one or two unchanged copies of the original Globs/Tracker Records file
— empty, with no passwords — in a folder or on disk with read-only access. You
can use these to replace a Records file if all else fails.

» Set the master password and write it down at home (or at least not anywhere
near the location where the software is being used). Since the master password
will probably be used infrequently, it may be harder to remember.

Passwords saved in a Records file are encrypted. Even if someone could see the
contents of a Records File, it would be difficult to determine from that information what
the passwords are. Records files are not text files; attempting to edit them like text files
would probably just make them unreadable by the Green Globs & Graphing Equations
program.

Change the Sound Settings for Users of this Records File

These settings control the availability of sound during a GREEN GLOBS game when a
shot hits a glob or a shot absorber. You can specify whether users are allowed to
switch sound on and off, and whether sound is initially set to on or off. The initial sound
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settings allow users to switch sound on and off, with sound set to on. If this is the
arrangement you want, you do not need to do anything.

When users are allowed to switch sound on and off, the last two menu items on the
GREEN GLOBS menu will be Sound On and Sound Off, with a check mark next to the
current setting. When users are not allowed to switch sound on and off, Sound On and
Sound Off are removed from the GREEN GLOBS menu, and the sound status remains at
the initial setting you selected. For example, you can turn sound off and keep it off for
users by selecting the sound settings “Sound is initially Off” and “Users cannot switch
sound from its initial setting”.

Sound settings are kept in Records files. Two Records files can have two different sets
of sound settings. To see or change the sound settings for a given user, look in the
Records file where that user's record scoring games would be saved. Sound settings
are checked only when a user opens the application, so changes you make to sound
settings will not affect users already using the software until they quit and re-open the
application. For convenience when creating new Records files, the passwords and
sound settings of the new Records file are copied from the Records file with which you
started. You can change the sound settings in the new Records file if you want.

Menu Items for Multiple Records Files

The remaining menu items in Teacher Options deal with having more than one Records
file. If you are using just one Records file (like the Globs/Tracker Records file which is
included in the package), then you can skip to the last section, titled Tips for Using
Green Globs & Graphing Equations on a Network, on page 91.

After these menu item descriptions , there is a discussion and example in the section
titted Using More Than One Records File on page 87.

Choose a Records File from your current list

This item is available only when you are dealing with a List of Records files. It allows
you to select one of the Records files on your list and then use the menu items
described above to see or change the records in that Records file. If the password kept
in the Records file you select is different from the password you last typed, you will be
asked to type the password for the selected Records file. If you cannot type the correct
password, you will have to start TEACHER OPTIONS again from the Programs menu,
using the Records file you started with.

Choose a Records File from the disk directory

This menu item allows you to select a Records file from any disk and folder you can
access, then use the menu items described above to see or change the records in that
Records file. If the password kept in the Records file you select is different from the
password you last typed, you will be asked to type the password for the selected
Records file. If you cannot type the correct password, you will have to start TEACHER
OPTIONS again from the Programs menu. This uses the standard Macintosh “Open...”
files dialog box, but only file names for Records-type files can be selected.
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Choose a List File [list of records file] from the disk directory

A List file contains a list of Records files. See the discussion Using More Than One
Records File after these TEACHER OPTIONS menu item descriptions. This menu item
allows you to select a List file from any folder you can access, then use the menu items
described above to see or change the Records files in that List. (You can also use
menu item “Edit or Save your current List of Records Files” to edit the List and save
your edited List on disk.) You will need to match the password of the first Records file in
the List. If the password kept in the Records file is different from the password you last
typed, you will be asked to type the correct password. If you cannot type the correct
password, you will have to start TEACHER OPTIONS again from the Programs menu.
After you have typed the correct password, you can select any Records file on the list
by selecting the menu item “Choose a Records File from your current list” described
above.

This uses the standard Macintosh “Open...” files dialog box, but only file names for
List-type files can be selected.

Create a new Records File

This menu item allows you to create new Records files. It uses the standard Macintosh
“Save...” dialog, where you select the disk drive and folder you want the new file to be
in, then type the new file name and click “Save” (or press Return). If you click Cancel,
nothing will be created and you will return to the main TEACHER OPTIONS display for your
current Records file. When you create a new Records file, the application will write
each section (1024 bytes) of the file to disk. A counter on your screen will show how
many sections remain to be written. A Records file uses about 50KB (50,000 bytes) of
disk space. (If you are on a slow network, you may want to be on the server when you
create new Records files.) Once a Records file has been created, it has all the disk
space it will need. A Records file does not increase or decrease in length as it is used.
After your new Records file has been created, it becomes the Records file you are
currently working on, to make it convenient for you to set the title and passwords — just
pull down the TEACHER OPTIONS menu and select “Change the Title of this Records File”
or “Change the Passwords of this Records File”. The title is initially blank, and the
passwords are initially copies of the password and master password on the Records file
you had when you started TEACHER OPTIONS.

If you are going to be using your new Records files in a List, remember that a List
identifies a file by the file name and the folder the file is in. (Technically, a List saves
the file name and the Macintosh’s ID number for the folder, so you can change the
folder's name without affecting the List.) If you change a file’s name or move it out of its
folder after including it in a List, that entry in the List will be incorrect. (If this happens,
you can fix it by using menu item “Edit or Save your current List of Records Files”
described later.)

Create a List of existing Records Files

This menu item allows you to create and save a List of Records files. The Records files
must already exist before you select this menu item. (If they do not exist, select the
menu item above this, called “Create a New Records File”.) You should know the
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password for the first file on your List. The Records files in a List do not need to be on
the same volume (disk). This uses the standard Macintosh “Open... ” files dialog. This
shows all folder names, but shows file names only for Records-type and List-type files.
Select the files you want on your list, clicking Open after each file selection. If you open
a List-type file, its List of Records files will be appended to the list (if any) of files that
you have so far.

When you are finished selecting files, click Cancel. This menu item only creates the
List, it does not save it on disk. When you click Cancel (or when your List hits the limit
of eleven Records files), you will be taken directly to the display for the next menu item,
“Edit or Save your current List of Records Files,” where you can make changes to your
List and save it as a List file on disk. If you want to discard your list and start over, just
select the menu item “Create a List of existing Records Files” again and you will start
over.

Edit or Save your current List of Records Files

This menu item allows to you edit a List, verify that the entries in a List are valid, and
save a List to disk. This is the only place where a List is saved on disk. Any changes
you make to a List in TEACHER OPTIONS do not affect the disk copy (if any) of the List
until you select this menu item and subsequently click the Save button. The other items
on the TEACHER OPTIONS menu are inactive while you are in this editing display. To
leave this display, click Exit. Remember that when someone starts Green Globs &
Graphing Equations with a List of Records files, any record scoring GREEN GLOBS or
TRACKER games will be saved in the first Records file on the List. The games in the
other Records files will just be available for watching replays. At the bottom of this
display are eight buttons:

Add

Use this to add more files to the List. A standard Macintosh “Open...” dialog
will let you identify the additional Records files — click Cancel when you are finished
adding. Added files are added to the end of the list, but you can move them after you
finish adding files. This button will be inactive if your list is already at the limit of eleven
Records files. The Records files in a List do not need to be on the same volume (disk).

Replace ) golect a file to be replaced, then click Replace. A standard Macintosh

“Open...” dialog will let you identify the replacement Records file. If a list entry has
become incorrect because of changes, use this option to update that entry, or use the
Delete option described below to remove it from the List. The Records files in a List do
not need to be on the same volume (disk).

Move J Select a file to move, click Move, then click at the position in the List where you

want the file to be.

Delete | golect a file to delete, click Delete, and the file will be removed from the List.

Files below it on the list will be moved up. This just deletes a Records file from this List;
it does not affect that Records file in any way.

Green Globs and Graphing Equations 85



Teacher Options

EXt_ This exits the editing display. If your List has changes which have not been
saved to disk, you will see an alert dialog asking if you want to save the list before
exiting. After exiting, you will be taken to the password entry display, where you will be

asked to match the password of the first Records file on your List.

Help ) This provides a one screen help display about List files. When you click OK,

you return to the editing display for your List.

>3Ve | This provides a standard Macintosh “Save...” dialog to save your List as a List-

type file. If you got this List by opening a List file, that file name will be shown as a
default file name. You can save your List as a replacement for an existing file, or as a
new file. A List file does not need to be saved on the same disk or in the same folder as
the Records files in the List. After you save your List as a List file, users who open that
List file (or an alias for it) in the Finder will start Green Globs & Graphing Equations with
that List as their List of Records files.

Verify ) Use this to verify that each entry in the List is valid. A file name entered in a
List can become invalid after you create the List if someone renames that file, deletes
that file, or moves that file to another folder.

Verification will check that:

v' Each file name exists in the named folder and is a Records-type file
v' The first file on the List (where users’ record scoring games will be saved) is not
Read Only
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Using More Than One Records File

One of the TEACHER OPTIONS lets you create additional Records files. Each Records file
uses about 50KB of disk space. You can name a Records file anything, and it does not
need to be in the same folder (or even on the same disk drive) as Green Globs &
Graphing Equations.

Here are some possible reasons to create additional Records files:

* You have two or more classes with different experience levels using the software
(e.g., a ninth grade and an eleventh grade).

* You have several classes using the software, and you want the records to hold the
top ten scores from each class instead of the top ten scores from all the classes
combined.

* You want an archive where you can copy selected games before they are bumped off
the top ten scores by higher scoring games.

* You want an archive where you can copy selected games from last year’s records
before reinitializing the records section for this year’s classes.

In the Finder, if you open the application Green Globs & Graphing Equations by
selecting it and choosing Open from the File menu (or double-clicking its icon), the
application will use the Records file named “Globs/Tracker Records” in the same folder.
(These two files are in the Green Globs publication folder, and must stay in the same
folder so that Green Globs & Graphing Equations can read your license information
from Globs/Tracker Records. An alternative way is to start Green Globs & Graphing
Equations from the Finder indirectly by opening any Records file (or opening any List
file, which holds a list of Records files, as discussed below). This is just like opening a
word processor’s document in order to start the word processor with that particular
document. If you start Green Globs & Graphing Equations by opening a Records file (or
List of Records files), the Records file (or List of Records files) can have any name and
can be anywhere — it does not need to be in the same folder as Green Globs &
Graphing Equations. If you create additional Records files for use by students, you may
want the students to be able to see other Records files besides the one where their own
record games are saved. If so, you can make a list of these Record files and save the
list in what this package calls a “List” file. An example of this is described below.

Green Globs & Graphing Equations must be able to find at least one Records file in
order to run.

List Files

When you have more than one Records file, you can arrange for users to start Green
Globs & Graphing Equations by opening a List file (which contains a list of Records
files). When this happens, Green Globs & Graphing Equations will assume the first
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Records file on the list is the file where the user’s record games should be saved, and
the other Records files on the list are just to be available for seeing their record games.

To create a list, you create the individual Records files, then you make a list of them in
the order you want (remember, the user’s record games will be saved in the first file on
the list), then you save the list in a new file (which we call a List File). The user then
opens this List file to start Green Globs & Graphing Equations. See the example in the
next section on this page. There is one caution in using List files: a List file saves a list
of Records files by saving each Records file’s name and the identification of the folder
the Records file is in. If you create a List file and then someone changes the name of
one of the Records files in your list, or moves that Records file to another folder, that
entry in your List file becomes invalid. To correct an invalid entry in a List file, choose
TEACHER OPTIONS and update that list entry by doing the following:

« If you didn’t start Green Globs & Graphing Equations with that List file, select
“Choose a List file from the disk directory” and open that List file. Or select menu
item Create a List of Existing Records Files to just create the list again.

 Edit your list to make any necessary changes.
» Save the updated list on the disk.

An Example using Records files, List files, and Aliases

Here is an example of one possible network installation, which puts some files on the
network server and some files on the individual computers. If you are not using a net-
work, the example still applies — you put all the files on your individual computer(s).
For this example, each computer on the network except the server would have its own
copy of the application file Green Globs & Graphing Equations on its own hard disk
drive, and the Records file(s) — like “Globs/Tracker Records” — would be on the
network server’'s hard disk drive.

Step 1: On the server create a folder (or use an existing one) to which everyone has
read and write access, but students cannot copy, rename, or delete the folder or the
files in it.

Step 2: Create the Records files you want in that folder (or move them to that folder if
they already exist). For this example, suppose there are three ninth grade classes and
you create three Records files named “GG Records Grade 9A”,

“GG Records Grade 9B”, and “GG Records Grade 9C”. (The names could be
anything.)

Step 3: If you want to have Lists of those Records files, create them. They can go in

that folder, or another folder on the server. For this example, you could create three List
files this way:

First, make this list:
GG Records Grade 9A
GG Records Grade 9B
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GG Records Grade 9C
and save it as List file “Green Globs List for Class 9A”.

Then make the following list (you can make it by editing your previous list using “Move”
to change the order):

GG Records Grade 9B

GG Records Grade 9A

GG Records Grade 9C

and save it as List file “Green Globs List for Class 9B”.

Then make a third list (by changing the order of your previous list):
GG Records Grade 9C

GG Records Grade 9A

GG Records Grade 9B

and save it as List file “Green Globs List for Class 9C”.

Note that each list has the same files as the other lists, only with a different one first.
Each class will have its own Records file in which to save record games, and each class
will be able to see the record games saved by the other two classes.

Step 4. Quit Green Globs & Graphing Equations and, in the Finder, make an “alias” for
each of your List files. For example:

Create an alias for List file “Green Globs List for 9A” and rename your new alias file to
“Start Green Globs — grade 9A”. (The names could be anything you want.)

Create an alias for List file “Green Globs List for 9B” and rename the new alias to “Start
Green Globs — grade 9B”.

Create an alias for List file “Green Globs List for 9B” and rename the new alias to “Start
Green Globs — grade 9C”.

Finally, put copies of each alias on each computer on the network.

Step 5: Put a copy of the application file Green Globs & Graphing Equations on each
computer (except the server), along with copies of each of the alias files created in step
4. These should go in folders which are read-only for students and/or are locked. They
do not have to go into one folder, and to avoid confusion it might be better to put Green
Globs & Graphing Equations in an out-of-the-way place and the alias files in a
prominent place.

For this example, each computer (except the server) would get copies of these four
files:

Green Globs & Graphing Equations
“Start Green Globs — grade 9A”
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“Start Green Globs — grade 9B”
“Start Green Globs — grade 9C”

That completes the Macintosh setup. A user can start Green Globs & Graphing
Equations by opening the appropriate alias file on the computer.

A nice feature of the above example is that the alias files on each computer point to a
List file on the server, not to individual Records files. That means you could make a
change to the list of Records files in a List file on the server, and the change would be
implemented without needing to update any files on the individual computers on the
network. The previous example would also work if there is one copy of the application
file Green Globs & Graphing Equations on the server instead of one copy on each of the
individual computers except the server, but there would be a startup delay waiting for
Green Globs & Graphing Equations to be sent over the network to individual computers.
In the example with a copy of Green Globs & Graphing Equations on each computer
except the server, only about 2KB would need to be sent over the network to each
individual computer to get started.

If you want a setup that allows the individual computers on the network to be able to use
Green Globs & Graphing Equations when the network is not working, the example setup
above with Green Globs & Graphing Equations on each computer will work if each
computer also has a Records file on it in a folder where the users can read and write the
Records file. When the network is not working, users would start Green Globs &
Graphing Equations by opening the substitute Records file. Green Globs & Graphing
Equations must have a Records file somewhere in order to start.

There is one other way to start Green Globs & Graphing Equations with more than one
Records file: select the Records files in the Finder, and then select Open from the
Finder's File menu. When you do this, Green Globs & Graphing Equations is started
and the OS X Finder gives it a list of the Records files you selected. This method is not
recommended because of the potential for confusion. Green Globs & Graphing
Equations assumes that the first Records file given to it is the one where your record
games should be saved, but with this method the listed order of Records files that the
OS X Finder gives Green Globs & Graphing Equations does not necessarily match the
sequence in which you selected the files. (This behavior may change in future versions
of the Finder.) The creation of List files as described in the example above is a better
way to set things up reliably to avoid confusion.
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Tips for Using Green Globs & Graphing Equations on a
Network

For students who will be starting Green Globs & Graphing Equations with a single
Records file, consider putting the Records file on the network server disk and putting an
“Alias” of that Records file on each computer on the network. (The same idea applies if
the students are starting with a List file -- a list of Records files.) This allows you to
make changes to the Records file on the server without needing to make any changes
to the individual computers on the network.

If a computer on the network requests from the server the top ten scores in e.g., the
TRACKER Novice Game, that will involve sending about 1KB over the network. If the
user then chooses to watch a replay of one of those record games, that will involve
sending about 1KB over the network for each game replayed. (Although a Records file
uses about 50KB of disk space, the application requests just the section of data that it
needs; each section is about 1KB long. The application never requests the entire
Records file.)

Whenever a student or a teacher sees a display showing record scores, the application
has just read that data from the Records file on disk — so the information is current at
the moment it is displayed. This is also the case even when the window is just being
refreshed, e.g., when you return to it after switching to other windows.

On a network, though, the information in a shared Records file on the server can be
changed by other users at any time, so it is possible for a student or teacher to select a
game which is no longer in that (or possibly any) position in the Records file.

When this obsolete display problem happens to a student, the student will see this
message:

“The record you selected has been moved to another position, deleted, or
incompletely recorded. Please select again.”

After the student presses return, the updated record scores will be read from the
Records file and displayed. Regardless of the number or frequency of changes to a
Records file, a student will never see one person’s record game attributed to another
person’s name.

When this obsolete display problem happens to someone using the TEACHER OPTIONS,
that person will see this message:

“That Records Section was just updated by someone else. Since the records
you were seeing were not current, your action was canceled. You can request it
again. Press RETURN to see the current records.”

After the teacher presses Return, the updated record scores will be read from the
Records file and displayed.

One or more teachers can make changes to a Records file at the same time students
are saving and replaying games in that Records file, without risking loss of data or
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unintended changes to data. When a student saves a record game, or a teacher makes
a change to a Records file, the application holds other requests to change that Records
file until the change is complete. (This guarantees data to be written in two places in
the Records file gets to both places before the next person starts making changes.) This
process usually takes just a second, but the application protects against two users
trying to make changes simultaneously, and anyone who is asked to wait will see this
message:

“Someone else is saving something in the Records file at this moment. Please
wait — this program will try again automatically every 5 seconds. To cancel
trying, click the mouse. Number of tries so far: [followed by a number that starts
at one and increments once every five seconds].”

In most cases, the student will succeed on the second try (five seconds after the first try
found someone else in the process of saving something). If the displayed number
continues to increment, some possible explanations are:

1. The application and the Records file are working correctly, but the network is
sending information at an extremely slow rate. (A computer needs to transfer only
about 3K over the network to save a record game, though.)

2. The application and the Records file are working correctly, but you have to wait a
little longer for several persons in line ahead of you to make changes. (For example, in
a new Records section with no games saved, when ten students simultaneously save
their games.)

3. The resource fork of the Records file has been reserved by one of the computers
and that computer has not released it. One way this could happen is if someone has
opened the Records file from a utility program. It might happen if a computer or a
network had a hardware malfunction while updating the Records file. Another way this
could happen is if there is a programming error in Green Globs & Graphing Equations.
If you suspect the latter, please contact technical support staff and describe the
situation to them.
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